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Глава 12 

Копирование Элементов: Операции Массива и 
Копирования 

В этой главе Вы изучите, как копировать элементы в Pro/ENGINEER. При создании сложных 
деталей и сборок, часто возникает потребность в получении копий. Назначение 
конструкции в этих случаях состоит в определении идентичных элементов или деталей, 
которые будут размещены в разных местах одной и той же модели. 

Цели 
В этой главе Вы изучите: 

• два способа копирования элементов: Массив и Копия. 

• Различия между Размерным Массивом и Массивом с Привязкой. 

• Изучите три различные опции массива: Однородный (Identical), Переменный (Varying) и 
Основной (General). 

• Укажете различные опции размещения для копии элемента. 

• Установите зависимости между различными копиями элемента. 

• Используете различные методы копирования. 

• Выберете копируемые элементы. 

• Укажете зависимости для копируемых элементов. 

• Используете опцию Transform для копирования поверхностей и опорных кривых. 

Создание Массивов 

Массивы используются для создания многократных вхождений (instances) отдельного элемента. 
Исходный элемент, на котором базируется массив, называется "ведущим элементом массива (pattern 
leader)". Существуют два способа определения массивов: 

• выполнить приращение размеров ведущего элемента массива. 

• привязаться к существующему массиву. 

Если значение размеров не увеличивается, система назначает значение размеров ведущего 
элемента массива всем вхождениям в массиве. 

Преимущества Массивов 
Метод создания копий элементов путем размножения в массиве имеет много преимуществ: 

• массив становится отдельным элементом 

• Массив является параметрическим. Поэтому можно изменять параметры массива и выполнять 
регенерацию. 
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• При изменении геометрии ведущего элемента массива система автоматически обновляет весь 
массив. 

• Система автоматически группирует вместе все объекты, принадлежащие массиву, в дереве 
модели для облегчения выбора. 

Типы Массивов 

Размерные Массивы 
В размерном массиве выполняется приращение значений существующих размеров ведущего 
элемента в одном или двух направлениях для определения вхождений массива. Если используется 
второе направление, система выполняет приращение для всех вхождений, созданных в первом 
направлении, затем, во втором направлении. 

Массивы с Привязкой 
В случае привязки, массив ссылается на существующий массив для определения местоположения 
новых вхождений. Этот тип массива доступен только, если ведущий элемент нового массива привязан 
к ведущему элементу существующего массива. Этот пример показан на следующем рисунке. 

Обратите внимание: 
В отличие от размерного массива, система не создает параметры количества вхождений или 
значений приращения в массиве с привязкой. Он получает эту информацию из массива, на который он 
ссылается. Массив с привязкой автоматически обновляется при изменении массива, на который он 
ссылается. 

 
Рисунок 1: Массив с привязкой 

Опции Массива 
• Существуют три опции создания массива: Однородный (Identical), Переменный (Varying) и 

Основной (General). 

 
Рисунок 2: Опции Массива 
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Pro/ENGINEER накладывает некоторые ограничения в зависимости от типа массива; эти ограничения 
перечислены в следующей таблице. 

Таблица 1: Ограничения массива 

Опции массива Скорость регенерации Изменение 
вхождений 

Возможность 
пересечения вхождений 

Однородный Высокая Нет Нет 

Переменный Средняя Да Нет 

Основной Низкая Да Да 

 
Рисунок 3: Параметры Массива 

 
Рисунок 4: Параметры Массива 

 
Рисунок 5: Массив в Двух Направлениях 
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Рисунок 6: Массив в Двух Направлениях 

Создание Круговых Массивов 
Для создания кругового массива отверстий, необходимо выполнить приращения углового размера, 
используя радиальное размещение. Однако, для эскизного элемента (типа выдавливания, выреза или 
ребра), следует создать внутреннюю опорную плоскость под углом. 

 
Рисунок 7: Круговой Массив Эскизного Элемента 
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Рисунок 8: Круговой Массив Эскизного Элемента 

Обратите внимание: 
Не используйте эскизную осевую линию для создания углового размера. Эскизная осевая линия не 
имеет связанного с ней направления и результаты массива могут быть не предсказуемы. 

Копирование Элементов 

После создания элемента, зачастую более эффективно использовать его повторно, чем создавать 
заново. Копирование � эффективный метод многократного дублирования элементов. Элемент 
Копирования позволяет создавать новые элементы, копируя существующие элементы в новое 
местоположение. Необходимо определить местоположение копии, выбрать копируемые элементы и, 
затем, установить атрибут зависимости или независимости размеров скопированного элемента. 

Определение Местоположения Копирования 
Для выбора местоположения копии, щелкните по одной из следующих опций в меню COPY 
FEATURE: 

• New Refs � указывает новые привязки элемента. Можно сохранить каждую привязку или 
указать другую (alternate). 

• Same Refs � сохраняет существующие привязки элемента. 

• Mirror � зеркально отображает элемент относительно планарной поверхности или опорной 
плоскости. 

• Move � указывает поворот и/или перенос. 
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Методы Копирования 
Элемент можно копировать путем определения новых привязок, используя те же привязки, путем 
зеркального отображения и перемещения. Используя любой из этих методов, можно определить, 
должны ли копия и исходные элементы использовать одинаковые размеры. 

Копирование Путем Переноса и Вращения Элементов 
При копировании элемента путем его переноса или вращения, необходимо определить привязку для 
направления переноса или вращения: нормаль к плоскости; прямую кривую, кромку или ось; или 
систему координат. 

 
Рисунок 9: Поворот 

Определение Зависимостей Скопированных Элементов 
Уровнем назначения конструкции, воплощаемого в модели можно управлять, делая скопированные 
элементы зависимыми или независимыми. 

• Independent (независимый) � система назначает каждому скопированному элементу 
собственные размеры, которые можно изменять без воздействия на оригинал. Аналогично, 
любые изменения, выполненные в оригинале, не влияют на копию. 

Обратите внимание: 
При копировании элемента из другой модели или версии, система автоматически делает геометрию 
независимой. 

 
Рисунок 10: Независимые Копии 

• Dependent (зависимый) � все размеры, которые не были измененными на момент создания 
копии, становятся зависящими от исходного элемента. В этом примере, два размера, 
указанные при создании копии, являются независимыми. Изменение одного из них на втором 
ребре воздействует только на второе ребро. Другие размеры зависимы и изменение их 
значений воздействует на оба ребра. 
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Рисунок 11: Зависимые Копии 

Совет: 
При создании зависимой копии, эту зависимость можно разорвать, используя опцию Make Indep в 
меню MODIFY. Независимыми можно делать отдельные размеры или все сечение. 

Выбор Элементов для Копирования 
Для выбора элементов для копирования, выберите одну из следующих опций в меню COPY 
FEATURE: 

• Click � выбирает копируемые элементы в текущей модели. 

• All Feat � выбирает все элементы в текущей модели. Эта опция доступна при выборе опций 
Mirror или Move. 

• FromDifModel � выбирает копируемые элементы из другой модели. Эта опция доступна при 
выборе опции New Refs. 

• FromDifVers � выбирает копируемые элементы из другой версии текущей модели (например, 
из xxxx.prt.3, если текущей является модель xxxx.prt.5). Эта опция доступна при выборе опций 
New Refs или Same Refs. 

Определение Опций Зависимости 
Для того, чтобы размеры скопированного элемента были независимы от их родительских размеров, 
используйте опцию Independent. Копии, созданные с использованием опций FromDifModel и 
FromDifVers автоматически становятся независимыми. 

Для указания того, которые размеры скопированных элементов (не измененные) должны зависеть от 
значений размеров родительских элементов, щелкните по опции Dependent. При создании зависимой 
копии, можно сделать все сечение или отдельные размеры независимыми путем выбора Modify и 
Make Indep. 

Совет: 
При использовании опции Mirror Geom вместо Copy, можно зеркально отображать геометрию всей 
модели относительно плоскости без создания новых элементов. Система добавляет привязку Merge в 
дереве модели. 
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Рисунок 12: Вхождения Элемента Копирования 

Лабораторный Практикум 

Цель 
После завершения этой темы необходимо научиться создавать базовые Размерные 
Массивы, Массивы с Привязкой и Поворотные Массивы эскизных элементов. Необходимо 
также научиться копировать элементы и детали, используя Элементы копирования. 

Метод 
• В Упражнении 1 будет создан размерный массив. Для достижения конечного результата будет 

размножен вырез и, затем, изменен угол паза. 

• В Упражнении 2 и 3 будет создан массив с привязкой и круговой массив соответственно. 

• В Упражнении 4 над моделью будет выполнена работа с использованием Элемента 
копирования и опций зеркального отображения геометрии.  

• В Упражнении 5 будет создано монтажное ушко на направляющем валу рулевой колонки с 
использованием различных опций копирования. 

Инструменты 
ПИКТОГРАММА ОПИСАНИЕ 

   Отображение скрытых линий 

   Опорная плоскость 

   Опорная ось 
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УПРАЖНЕНИЕ 1: Создание и Изменение Размеров Массива 

 
Рисунок 13: Размерный Массив Выреза 

Задача 1. Открыть существующую деталь, которая будет использована для создания массива. 

1. Щелкните по  и откройте DIM_PATTERN.PRT. 

2. Щелкните по  [Скрытая линия]. 

Задача 2. Создание переменного массива выреза. 

1. Щелкните по Feature > Pattern и выберите вырез. 

2. Щелкните по Varying > Done. 

3. выберите размер 10  в вырезе. 

4. В ответ на запрос введите [4] в качестве значения приращения между компонентами массива и 
нажмите <ENTER>. 

5. Щелкните по Done в меню EXIT. 

6. Введите [12] в качестве количества вхождений в этом направлении и нажмите <ENTER>. 

7. Щелкните по Done в меню EXIT еще раз. 

 
Рисунок 14 Переменный Массив 
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Задача 3. Изменить угол ведущего элемента, чтобы изменить угол всего массива. 

1. Щелкните по Modify. Укажите вырез. выберите размер 45° и введите [-45] в качестве нового 
значения, нажмите <ENTER>. 

2. Регенерируйте модель. 

3. Сохраните модель и сотрите ее из оперативной памяти. 

УПРАЖНЕНИЕ 2: Создание Массива с Привязкой 

 
Рисунок 15: Массив с привязкой 

Задача 1. Начать создание массива с привязкой. 

1. Откройте файл REF_PATTERN.PRT. 

Задача 2. Создайте однородный массив отверстий в двух направлениях. 

1. Щелкните по Feature > Pattern и выберите отверстие. 

2. Щелкните Identical > Done. 

3. выберите размер 20, введите [20] в качестве нового значения и нажмите <ENTER> 

4. Щелкните по Done в меню EXIT. 

5. Введите [3] в качестве общего количества вхождений. 

6. Теперь выберите размер 10, введите [20] и нажмите <ENTER>. 

7. Так как это - единственный размер, который будет увеличен во втором направлении, щелкните по 
Done в меню EXIT. 

8. Введите [2] в качестве общего количества вхождений в этом направлении. 

 
Рисунок 16: Однородный Массив Отверстий в Двух Направлениях 
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Задача 3. Создать квадратный вырез на ведущем элементе массива, чтобы можно было создать 
массив с привязкой. 

1. Щелкните по Insert > Cut > Extrude. 

2. Щелкните по One Side > Done. 

3. выберите верхнюю поверхность выдавливания в качестве эскизной плоскости. 

4. Щелкните по ОК в меню DIRECTION. 

5. Щелкните по Default для ориентации. 

6. Удалите текущие привязки в диалоговом окне REFERENCE. 

7. Укажите ось A_1 в качестве привязки. 

Задача 4. Создать эскиз сечения, показанный на следующем рисунке. 

1. Работа выполняется на показанном ведущем элементе, чтобы позже он мог действовать в качестве 
элемента привязки. 

2. Нарисуйте вертикальные и горизонтальные осевые линии, проходящие через ось A_1. 

3. Сделайте эскиз квадрата, центрированном по отношению к оси A_1. Необходимо установить 
зависимости равной длины линии и симметрии. 

 
Рисунок 17: Сечение для Паза 

4. Измените ширину на 10мм. Модель регенерируется автоматически. 

5. Щелкните по  для выхода из эскиза. 

6. Удалите материал внутрь выреза. 

7. Щелкните по Blind > Done. Введите [2.5] в поле глубины. 

8. Завершите работу над элементом. Щелкните по ОК. 

Задача 5. Создать массив с привязкой элемента выреза. 

1. Щелкните по View > Model Tree. Щелкните правой кнопкой мыши по Cut id 1205 и выберите Pattern 
в выпадающем меню. 

2. Задайте массив, используя привязку к ведущему элементу. Щелкните по Ref Pattern > Done. 

3. Сохраните деталь и сотрите ее из оперативной памяти. 
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УПРАЖНЕНИЕ 3: Создание Круговых Массивов Эскизных Элементов 
Задача 1. Начать создание кругового массива. 

1. Щелкните по File > Open > Project и откройте BLOWER.PRT. 

2. Щелкните по  [опорная плоскость] и по  [опорная ось] для отображения опорных плоскостей и 
осей. 

 
Рисунок 18: Основание Вентилятора с Показанными Размерами 

Задача 2. Создать горизонтальную / вертикальную плоскость привязки для эскиза с ассоциативным 
углом. 
1. Щелкните по Insert > Protrusion > Extrude. 
2. Щелкните по One Side > Done. 
3. выберите верхнюю поверхность диска в качестве эскизной плоскости для лопаток вентилятора. 
4. Щелкните по ОК, чтобы принять направление по умолчанию. 
5. Щелкните по Bottom в меню SKET VIEW. 
6. Щелкните по Make Datum в меню SETUP PLANE. 
7. Щелкните по Through; затем Query Sel и выберите ось A_1. 
8. Щелкните по Angle, затем выберите DTM3 и щелкните по Done. 
9. Щелкните по Enter Value и введите [30]. 
10. Укажите в качестве привязок внешнюю кромку круглого выдавливания и только что созданный 
опорный элемент. Элементы DTM3 или DTM1 не должны быть выбраны в качестве привязок. 
11. Выполните эскиз сечения как показано на следующем рисунке. Убедитесь, что нижняя 
прямолинейная кромка имеет зависимость перпендикулярности к внешней кромке выдавливания. 

 
Рисунок 19: Эскиз Сечения 
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Совет: 
Для облегчения при создании эскиза, следует выполнить его заведомо большим, затем изменить 
размеры соответствующим образом. 

12. Выполните схему образмеривания, как показано. Введите [73.5] в качестве глубины выдавливания. 

 
Рисунок 20: Эскиз Лопатки Вентилятора 

Задача 3. Скопировать элемент выдавливания лопатки в одном направлении, используя переменный 
массив. 

1. Щелкните по Pattern и укажите элемент выдавливания лопатки. 

2. Щелкните по Modify > Done. 

3. выберите размер 30. 

4. Введите [60] в качестве значения приращения и нажмите <ENTER>. 

5. Не задавайте приращений остальных размеров. Щелкните по Done. 

6. Введите [6] в качестве количества вхождений массива. 

7. Не создавайте вхождения во втором направлении. Щелкните по Done в меню EXIT. 

 
Рисунок 21: Массив Лопаток 
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УПРАЖНЕНИЕ 4: Элементы Копирования 

 
Рисунок 22: Элементы Копирования 

Задача 1. Выполнить регенерацию существующей модели и скопировать некоторые элементы. 

1. Откройте файл детали FEATURE_COPY_MIRROR.PRT. 

2. Измените отображение на скрытые линии. 

Задача 2. Копии можно делать зависимыми или независимыми. Выбор варианта зависит от 
назначения проектируемой конструкции. В данном примере будет создана зависимая копия нижнего 
правого паза. 

1. Щелкните по Feature > Copy. 

2. Щелкните по Same Refs. 

3. Щелкните по Dependent > Done. 

4. выберите паз. Щелкните по Done в меню SELECT FEAT. 

5. выберите переключатели Dim 1 и Dim 3, соответственно угол 45° и 65-дюймовый размер. Щелкните 
по Done. 

6. Для Dim 1 введите [0.00] и нажмите <ENTER>. 

7. Для Dim 3, введите [410.00] и нажмите <ENTER>. 

8. Щелкните по ОК. 

9. Дважды щелкните по Done для возврата к меню верхнего уровня. 

Задача 3. Поэкспериментировать с изменением размеров; затем сделать копию, независимую от 
родительского паза. 

1. Щелкните по Modify и выберите родительский паз. 

2. выберите размер 125.00, введите [75.00] в качестве нового значения и выполните регенерацию. 

3. Верните длину паза к 125.00, как описано в предыдущем шаге. 

4. Измените угол 45° родительского паза. Введите [30.00]. Обратите внимание на то, что угол копии не 
изменяется, потому что зависимость этого размеры была разорвана при его изменении для создания 
копии. 

5. Измените угол родительского паза для сохранения 45°. 

Задача 4. Разорвать зависимость между двумя пазами. 

1. Щелкните по Make Indep в меню MODIFY. 
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2. Щелкните по Section в меню MAKE INDEP. 

3. выберите копию и щелкните по Done Sel и Done. 
4. Все размеры копии теперь не зависят от родительского паза. 

Задача 5. Существует возможность выполнить зеркальную копию всей модели, используя различные 
опции. Выполните эту операцию для всех элементов, используя Copy. 

1. Щелкните по Copy в меню FEAT. 

2. Щелкните по Mirror > All Feat > Independent в меню COPY FEATURE; затем щелкните по Done. 

3. выберите DTM1. 

4. Сохраните модель и сотрите ее из оперативной памяти. 

УПРАЖНЕНИЕ 5: Построение Рулевой Колонки 

 
Рисунок 23: Направляющий Вал Рулевой Колонки 

Задача 1. Создать копию первого ушка внизу вала под углом 90° по отношению к первому. Для этого 
используйте опцию перемещения в операции копирования. 

1. Откройте STEERING_COLUMN.PRT. 

2. Отобразите оси и опорные плоскости, если они еще не показаны. 

3. Щелкните по Feature > Copy > Move > Select > Dependent > Done. 
4. выберите элементы выдавливания, ось, отверстия и скругление, которые составляют первое ушко в 
Дереве модели; затем щелкните по Done Sel > Done. 

 
Рисунок 24: Копируемые Элементы 

5. Щелкните по Translate. 

6. Отобразите опорные плоскости   и выберите опорный элемент FRONT. 

7. Измените направление стрелки, чтобы она указывала в соответствующем направлении. Щелкните 
по ОК. 
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Рисунок 25: Привязки для Переноса 

8. Введите [7.5] в качестве значения переноса. 

9. Щелкните по Rotate > Crv/Edg/Axis. 

10. выберите ось A1 в качестве привязки перемещения для поворота. (включите , если оси не 
отображаются). 

11. Направьте стрелку, как показано на следующем рисунке. Введите [90] в качестве значения 
поворота. 

 
Рисунок 26: Направление Поворота 

12. Щелкните по Done Move для завершения перемещения. 

13. Элемент полностью определен. Щелкните по ОК. 

Задача 2. Зеркально отобразите скопированное ушко относительно опорного элемента SIDE. 

1. Щелкните по Feature > Copy > Mirror > Dependent > Done. 

2. выберите скопированное ушко в Дереве модели. Щелкните по Done. 

Обратите внимание: 
Поскольку система разместила скопированные элементы ушка в группе, их можно выбирать как 
отдельный элемент. 

3. Отобразите ушко относительно опорной плоскости SIDE. 

 
Рисунок 27: Зеркальная Копия Ушка 
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Задача 3. Сделать исходное ушко более длинным и утолстить его для упрочнения. Так как другие два 
ушка являются зависимыми копиями, разорвите их зависимость и создайте толщину, которая 
отличается от толщины оригинала. 

1. Щелкните по Modify. выберите выдавливание (protrusion id 50) оригинального ушка. 

2. Измените длину 2.00 на 3.00 и толщину 0.25 на 0.375. 

3. Регенерируйте модель. 

4. Обратите внимание, что два скопированных ушка также изменили свою толщину. Однако, их длина 
не изменилась. Это произошло потому, что при копировании первого ушка, ему была назначена новая 
длина, которая автоматически сделала длинновой размер независимым. 

Задача 4. Разорвать зависимость толщины между ушками. 

1. Щелкните по Modify > Make Indep > Dimension. Снова выберите выдавливание ID 50 и размер 
толщины 0.375. 

2. выберите элементы, чтобы сделать размер независимым. Обратите внимание на 2 подсвеченных 
зависимых ушка. 

3. выберите оба скопированных ушка в модели. Щелкните по Done Sel > Done Sel. 
4. Измените одно из скопированных ушек. Введите [0.125] в качестве толщины. Введите [60] в 
качестве нового значения для угла поворота в 90°; затем выполните регенерацию. 

5. Сохраните модель и сотрите ее из оперативной памяти. 

 
Рисунок 28: Завершенный Направляющий Вал Рулевой Колонки 

Резюме 

В этом модуле, Вы узнали что: 

• Операция копирования является важной для сохранения назначения конструкции и 
Pro/ENGINEER реализует эту функцию посредством Массива и Копирования. 

• Массивы бывают двух типов: Размерный Массив и Массив с Привязкой. 

• Существуют три опции массивов: Однородный (Identical), Переменный (Varying) и Основной 
(General). 

• В поворотном массиве, например отверстия: угловой размер должен быть увеличен с 
использованием радиального расположения. 

• Между Копиями элементов могут быть установлены Зависимые и Независимые отношения. 

• Копия части геометрии может быть создана с использованием операций Переноса и 
Зеркального Отображения. 
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Глава 13 

Создание Сборок 

В этом уроке Вы научитесь создавать сборки. 

Цели 
В этом модуле, Вы научитесь: 

• создавать сборки. 

• Изменять сборки. 

Краткий Обзор 

Для создания сборки, необходимо соединить компоненты (детали), выбирая поверхности и элементы. 
Существуют несколько моментов при создании сборки: 

• всегда начинайте сборку с базового компонента, компонента, который очень нежелательно 
удалять позже из сборки. 

• Сборку целесообразно разбивать на подсборки (узлы). 

• Начинайте собирать узел с опорных плоскостей. 

• Добавляйте первую деталь или узел согласно опорным элементам по умолчанию сборки. 

 
Рисунок 1: Опорные Плоскости По умолчанию Сборки 

Вектор, Нормальный к Поверхности 
Вектор, нормальный к поверхности - мнимый вектор, который является перпендикулярным к 
поверхности модели. Pro/ENGINEER различает поверхности внешней и внутренней стороны, которые 
содержат твердотельных модели. 
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Рисунок 2: Вектора, Нормальные к Поверхности Модели 

Наложение Зависимостей на Компоненты Детали 
Зависимости размещения создают отношения родитель / потомок между собранными компонентами и 
новыми, добавляемыми компонентами. Ниже приведен список часто используемых зависимостей: 

• Mate (Сопряжение) � векторы, нормальные к выбранным поверхностям, указывают в 
противоположных направлениях и становятся копланарными. 

 
Рисунок 3: Зависимость Сопряжения 

Mate Offset (Сопряжение со смещением)� векторы, нормальные к выбранным поверхностям, 
указывают в противоположных направлениях и смещены на указанное отрицательное или 
положительное расстояние. 

 
Рисунок 4: Зависимость Сопряжения со Смещением 

Align (Выравнивание) � векторы, нормальные к выбранным поверхностям, указывают в одном 
направлении и становятся копланарными. Выравнивание также делает две оси соосными. 

Обратите внимание: 
Pro/ENGINEER не связывает направление с выравниванием оси. 
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Рисунок 5: Зависимость Выравнивания 

Align Offset (Выравнивание со смещением) � векторы, нормальные к выбранным поверхностям, 
указывают в одном направлении и смещены на указанное отрицательное или положительное 
расстояние. 

 
Рисунок 6: Зависимость Выравнивания со Смещением 

 
Рисунок 7: Используемые Привязки для Ориентирующих Зависимостей 

Insert (Вставка) � выбранные цилиндрические поверхности вращения становятся соосными. Эти 
поверхности не обязательно должны полными цилиндрами на 360°, как показано на рисунке ниже. 

 
Рисунок 8: Зависимость Вставки 
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Размещение Компонентов 
Все зависимости, типа mate, align, insert и coord sys, - доступны в единственном диалоговом окне 
размещения компонентов. Как показано в нижнем рисунке, это позволяет эффективно планировать 
последовательность размещения. 

 
Рисунок 9: Интерфейс Размещения Компонентов 

В диалоговом окне Component Placement (Размещение Компонентов) доступны следующие элементы: 

• Сводный список сборочных зависимостей, начинающийся с Automatic и находящийся в 
выпадающем списке. 

• Кнопка Flip для изменения ориентации компонента на 180°. 

• Редактируемое значение отступа в списке зависимостей. 

• Меню пиктограмм в верхней части диалогового окна, которое позволяет: 

− контролировать, будет ли новый компонент появляться в окне Сборки или в новом окне. 

− Переключаться между опциями диалогового окна Constraint Placement и Move. 

− Фиксировать компонент или размещать его в положении по умолчанию. 

− Взаимодействовать с вызовом компонентов. 

− Изменять настройки. 

Компоновка Незавершенных Компонентов 
Незавершенные компоненты - те компоненты, ориентирование которых в сборке не завершено. Это 
означает, что имеются некоторая неопределенность в размещении компонентов, которую 
Pro/ENGINEER не может разрешить. Эта ситуация может быть разрешена при помощи компоновки 
(packaging). 

Компоновка позволяет: 

• добавлять компоненты в сборку без полного их определения. 

• Добавлять компоненты в сборку без определения их истинного или окончательного 
местоположения. 
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• Резервировать пространство сборки для компонентов, которые будут добавлены позже. 

Переопределенные Компоненты 
Излишнее ограничение (over-constrain) компонента означает, что было добавлено большее 
количество зависимостей, чем это необходимо для выполнения требований назначения конструкции. 

Изменение Сборок 

Так как Pro/ENGINEER является ассоциативной программой, то можно изменять компоненты в узле в 
процессе работы в сборке. Однако, система ограничивает масштабы таких изменений посредством 
опций меню MOD ASSEM, перечисленные ниже: 

− Mod Dim � позволяет изменять любой размер в сборке. 

− Mod Assem � позволяет изменять размеры только в сборке верхнего уровня. 

− Mod Subasm � позволяет изменять любую подсборку в сборке верхнего уровня, которая 
включает собранные компоненты в подсборке. 

− Mod Part � позволяет изменять детали в сборке, а именно � изменять размеры, 
переопределять существующие элементы, добавлять новые элементы, а также выполнять 
большинство операций уровня детали. 

Обратите внимание: 
При создании элементов детали на уровне сборок, необходимо быть внимательным во избежание 
создания нежелательных отношений родитель / потомок между деталью и сборкой. 

Изменение Назначения Конструкции 
Назначение конструкции можно изменять следующими командами: 

− Reorder � изменяет порядок, в котором система регенерирует компоненты сборки. 

− Insert Mode � вставляет компонент между двумя компонентами в процессе регенерации 
сборки. 

− Reroute � изменяет внешние привязки, используемые компонентом для привязок. 

− Delete � удаляет элементы компонентов или сборок из модели сборки. 

− Suppress � временно удаляет компоненты из сборки. 

− Resume � восстанавливает компоненты в модели сборки. 

Сохранение Сборок 
При сохранении сборки, система автоматически сохраняет все изменения, сделанные в любой из 
деталей этой сборки. 

Обратите внимание: 
Если деталь, находящаяся в сборке, была переименована, и сборка не находится в памяти, операция 
размещения не сможет быть выполнена при регенерации этой сборки. 
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Другие Опции Сборки 

Генерация Спецификации 
Спецификация (Bill of Material - BOM) � список подсборок и компонентов, включающий количество 
компонентов. В Pro/ENGINEER можно генерировать спецификацию в выпадающем меню Info. 

Создание Покомпонентых Видов 
Используя опцию Explode в выпадающем меню View, можно создавать покомпонентые виды модели 
сборки. 

Обратите внимание: 
В покомпонентном виде нельзя собирать компоненты сборки. При попытке вставить компонент, 
система запросит отменить покомпонентный вид сборки, используя опцию Unexplode в выпадающем 
меню View. 

 
Рисунок 10: Сборка Механизма 

 
Рисунок 11: Покомпонентная Сборка Механизма 

Лабораторный Практикум 

Цель 
В этом упражнении Вы научитесь создавать и изменять сборки. 

Метод 
− В Упражнении 1 существующие компоненты будут собраны в подсборку, используя 

зависимости вставки, сопряжения и выравнивания в диалоговом окне Component Placement. 

− В Упражнении 2, будет собран механизм рукоятки с использованием подсборки, собранной в 
Упражнении 1. 
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Инструменты 
ПИКТОГРАММА ОПИСАНИЕ 

   Размещает компонент в положении по умолчанию 

   Показывает компонент в отдельном окне 

   Определяет новую зависимость 

    Удаляет выбранную зависимость 

    Изменяет ориентацию зависимости (переворачивает) 

УПРАЖНЕНИЕ 1: Создание Подсборки из Трех Деталей 

 
Рисунок 12 Завершенная Подсборка 

Задача 1. Начните создавать узел. 

1. Щелкните по . выберите Assembly и введите [BASE] в качестве названия. Переключатель Use 
default template должны быть включен. 
2. В менеджере меню щелкните по Set Up > Units. > millimeter Newton Second > Set. 
3. Щелкните по ОК > Close. 

4. Прокрутите меню вниз, щелкая по синей стрелке, затем, щелкните по Done для возврата в меню 
верхнего уровня. 

Задача 2. Собрать деталь скобу. 
1. Щелкните по Component > Assemble и откройте BRACKET.PRT из рабочего каталога. 

2. В диалоговом окне COMPONENT PLACEMENT щелкните по  [собрать в местоположении по 
умолчанию]. 

3. Щелкните по ОК. 

Задача 3. Собрать деталь втулку с деталью скоба. 

1. Щелкните по Component > Assemble и откройте BUSHING.PRT. 

2. Выключите отображение опорных плоскостей. 
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Рисунок 13: Сборка Втулки 

Задача 4. Вставить втулку в скобку, используя поверхности вращения моделей. 
1. Тип зависимости по умолчанию в диалоговом окне COMPONENT PLACEMENT - Automatic. 
2. Щелкните по Insert в выпадающем списке. 

3. Укажите внешнюю цилиндрическую поверхность втулки и внутреннюю поверхность вращения 
выреза на скобе. 

 
Рисунок 14: выберите привязки Компонента для Вставки 

Задача 5. Сопрячь поясок на втулке с задней поверхностью скобы. 

1. Щелкните по Mate в выпадающем списке CONSTRAINT TYPE. 

2. Щелкните по плоской поверхности фланца на втулке, показанной курсором на следующем рисунке. 

 
Рисунок 15: Выбор Привязок для Зависимости Сопряжения 
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3. выберите заднюю поверхность скобки, используя Query Sel, подсвеченной в предыдущем рисунке. 
Щелкните по Accept, когда требуемая поверхность подсветится. 

4. Введите [0] в качестве значения отступа и нажмите <ENTER>. 

5. Pro/ENGINEER сопрягает две детали. 

6. Теперь щелкните по  [изменение ориентации зависимости]. Обратите внимание, что втулка 
изменяет направление сопряжения. 

7. Щелкните еще раз по  для возврата в первоначальное положение. 

Задача 6. Добавить третью зависимость Выравнивания, чтобы лыска на втулке совпала с лыской паза 
в скобе. 

1. Щелкните по  [отобразить компонент в отдельном окне]. 

2. Втулка отображается в отдельном окне. 

3. В новом окне, выберите лыску втулки, как показано на следующем рисунке. 

 
Рисунок 16: Выбор Привязок для Зависимости Выравнивания 

4. Теперь щелкните по верхней поверхности скобки, как показано. 

5. Примите величину смещения по умолчанию около области сообщения. 

6. Фактически этот отступ не нужен. Поэтому щелкните по величине отступа в диалоговом окне 
COMPONENT PLACEMENT для получения выпадающего списка. 

 
Рисунок 17: Ориентирование Втулки Относительно Скобы 

7. Щелкните по Oriented и OK. 

8. Узел полностью определен. 

Обратите внимание: 

Созданные зависимости всегда можно удалить, щелкая по , и определить новую зависимость, 
щелкая по . 
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Задача 7. Собрать кольцо с втулкой, используя зависимости. 

1. Выключите отображение опорных плоскостей. 

2. Щелкните по Assemble; затем выберите RING.PRT 

3. Изменить масштаб изображения втулки, чтобы можно было видеть углубление пружинного упорного 
кольца более ясно. 

 
Рисунок 18: Зависимости для Сборки Основания с Кольцом 

4. Добавьте зависимость вставки между внутренней поверхностью вращения пружинного упорного 
кольца и небольшой поверхностью вращения канавки во втулке. 

5. Добавьте зависимость сопряжения между передней поверхностью стороны основания и задней 
частью пружинного упорного кольца, как показано в предыдущем рисунке. 

6. Ориентируйте ушки так, что бы они соответствовали ориентации плоской поверхности втулки. 
Щелкните по поверхностям, показанным на следующем рисунке. 

 
Рисунок 19: Выравнивание Пружинного Упорного Кольца по Плоской Поверхности Втулки 

7. Примите величину отступа по умолчанию нажатием <ENTER>, но измените смещение на Oriented в 
диалоговом окне COMPONENT PLACEMENT. 

8. Щелкните по ОК. 

9. Щелкните по  и закройте окно. 
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УПРАЖНЕНИЕ 2: Создание Сборки Механизма 
Задача 1. Начать создавать новую сборку. 

1. Щелкните по , выберите Assembly и введите [MACHINE] в качестве имени. Выключите опцию 
Use default template. 

2. Настройте сборку на использование единиц измерения миллиметры. Щелкните по Set Up >Units > 
millimeter Newton Second > Set > OK > Close. 

3. Щелкните по Insert > Datum для создания трех элементов опорных плоскостей по умолчанию. 

Задача 2. Собрать базовую сборку в сборку механизма, используя опорные плоскости. 

1. Щелкните по Component > Assemble; затем откройте BASE.ASM. 

2. Соберите базовую подсборку со сборкой механизма, щелкая по  [собрать в местоположении по 
умолчанию]. 

Задача 3. Собрать компонент вала, используя зависимости. 

1. Соберите деталь MASTER_SHAFT со сборкой механизма. 

2. Вставьте вал в отверстие втулки. 

 
Рисунок 20: Выбор Привязки для Зависимости Выравнивания 

3. Создайте зависимость Align между торцевой поверхностью вала и поверхностью скобы. 

4. Введите величину смещения [100] и нажмите <ENTER>. 

Задача 4. Добавить к сборке кривошип, используя сборочные зависимости. 

 
Рисунок 21: Сборка Детали Кривошипа со Сборкой Механизма 

1. Соберите кривошип. 

2. Вставьте кривошип на вал. 
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Рисунок 22 Собранный Кривошип 

3. Выровняйте маленькое отверстие на кривошипе с маленьким отверстием на валу, щелкая по оси. 

4. Система сообщает, что сборка полностью ограничена, но необходимо ориентировать заднюю часть 
кривошипа на конец вала. 

Задача 5. Собрать шестерню в механизм. 

1. Соберите шестерню в сборку, используя зависимости, подобные тем, которые были использованы 
для кривошипа. 

2. Сохраните сборку. 

Задача 6. При работе на уровне сборки, выполнить изменение в назначении конструкции, изменяя 
ширину скобы. 

1. Щелкните по Modify в меню ASSEMBLY. 

2. Щелкните по Mod Part в меню ASSEM MOD. 

3. выберите скобу. 

4. выберите базовый элемент для отображения размеров. 

5. выберите размер 25. Введите [50.0], затем нажмите <ENTER>. 

6. Регенерируйте только модель детали. 

Задача 7. Выполнить другое изменение в назначении конструкции, добавляя радиус скругления 
боковой кромки окружности на двух верхних кромках скобы. 

1. Создайте новый элемент детали. Щелкните по Feature > Create. 

2. Добавьте простой радиус скругления боковой кромки окружности к скобе величиной 20мм. 

 
Рисунок 23: Измененная Скоба 

Задача 8. Создать Спецификацию для этой сборки. 

1. Щелкните по BOM в выпадающем меню INFO. Щелкните по ОК. 
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2. Полностью изучите ИНФОРМАЦИОННОЕ ОКНО; используйте линейки прокрутки при 
необходимости. 

3. Щелкните по Close в ИНФОРМАЦИОННОМ ОКНЕ 

4. Закройте рабочее окно. 

5. Сотрите все не отображаемые модели. Щелкните по File > Erase > Not Displayed. 

Резюме 

В этом модуле, Вы узнали что: 

• Создание сборки следует начинать с базовых компонентов и использовать Опорные 
Элементы Сборки по умолчанию. 

• Существуют различные зависимости для добавления новых компонентов в сборку. 

• Компоненты сборки, в случае необходимости, могут быть недоопределены или 
переопределены. 

• Компоновочные или недоопределеные компоненты добавляются в сборку для получения 
пространственного представления законченной сборки. После завершения, на такой 
компонент могут быть наложены все требуемые зависимости. 

• Избыточное определение бывает необходимо для сохранения дополнительного назначения 
конструкции. 

• По причине ассоциативности Pro/ENGINEER можно выполнять изменения во всех компонентах 
или подсборках в процессе работы над сборкой. 

• Изменение деталей на уровне сборки подразумевает принцип конструирования сверху-вниз 
(top-down). Иногда это необходимо для сохранения назначения конструкции верхнего уровня 
при создании геометрии детали в контексте сборки. 

• Из сборки можно извлекать спецификацию (Bill of Materials). 

• Можно создавать покомпонентные изображения сборок. 
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Глава 14 

Принципы Конструирования Сверху-Вниз 

В этой главе Вы изучите принципы конструирования сверху-вниз. Надежные модели могут 
быть построены только при строгом следовании принципам нисходящего (top-down) 
проектирования. 

Цели 
В этой главе Вы изучите: 

• описание принципов проектирования сверху-вниз. 

• Перечень преимуществ проектирования сверху-вниз. 

• Описание инструментов Pro/ENGINEER, поддерживающих процесс проектирования сверху-
вниз. 

• Методы управления привязками применительно к способу проектирования сверху-вниз. 

Введение 

Определение 
Проектирование сверху-вниз - метод проектирования изделия, состоящий в определении критериев 
конструкции верхнего уровня и, затем, передаче этой информации из структуры изделия верхнего 
уровня ко всем связанным подсистемам. 

Стадии Проектирования Сверху-Вниз 
• Планирование 

• Создание структуры изделия 

• Совместное использование специфической конструкторской информации 

• Понимание принципов взаимодействия между отдельными компонентами 

Подход 
Проектирование сверху-вниз может быть задумано как непрерывный процесс сбора данных, 
взаимодействия и управления информацией по проекту. Это � лучший способ для использования и 
управления инструментами ассоциативного проектирования Pro/ENGINEER при осмыслении и 
построении больших сборок. 
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Рисунок 1: Архитектура Проектирования Сверху-Вниз 

Сравнение Проектирования Сверху-Вниз с Традиционным Подходом 
При проектировании сверху-вниз распределение информации происходит с верхнего уровня 
проектирования к нижним. 

 
Рисунок 2: Распределение Информации Сверху Вниз 

При традиционном подходе к конструированию сборок, инженер проектирует индивидуальные 
компоненты независимо от сборки, используя ручной подход для обеспечения того, что компоненты 
будут согласованы должным образом и будут отвечать требованиям проекта. 

 
Рисунок 3: Традиционный Подход к Проектированию 

Характеристики Традиционного Подхода к Проектированию 
• Конструктор помещает компоненты в подсборки и, затем, стыкует эти узлы вместе для 

создания сборки верхнего уровня. 

• Зачастую, после создания сборок, конструктор выясняет, что модели не отвечают критериям 
конструкции (например, место соединения двух моделей не согласуется). 

• После обнаружения проблемы, конструктор вручную изменяет каждую модель. 
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• По мере роста сборки, процесс определения и исправления таких несоответствий требует 
значительного количества времени. 

Преимущества Метода Проектирования Сверху-Вниз 
Метод проектирования сверху-вниз имеет много преимуществ. Он может использоваться для 
управления большими сборками, организации сложных проектов, управления перемещением и более 
гибкой поддержки сборочных конструкций. 

Эта методология может использоваться для управления большими сборками, позволяя пользователю 
регенерировать только скелетную структуру сборки в памяти и выполнять требуемые изменения. 
Скелет (skeleton) содержит важные критерии конструкции типа посадочных мест, свободного места 
для подсистем и деталей и конструктивные параметры типа критических размеров. В скелете могут 
быть сделаны изменения и эти изменения будут переданы в подсистемы всего проекта. 

Проектирование сверху-вниз организует и помогает увеличивать взаимодействие и зависимости 
между компонентами сборки. В фактическом проекте сборки существует множество взаимодействий и 
зависимостей, и их требуется учесть в модели проекта. Пример требуемых зависимостей - 
местоположение посадочного отверстия в одной детали и соответствующее местоположение в другой 
детали. Поэтому, если одно из посадочных отверстий перемещается, соответствующее установочное 
отверстие на ответной детали также перемещается. В Дереве модели существуют инструменты, 
позволяющие пользователям использовать требуемые зависимости, ограничивая нежелательные. 

Организованная структура сборки позволяет разделять информацию между различными уровнями 
сборки. Если на одном из уровней сборки сделано изменение, оно будет разделено между всеми 
другими связанными сборками и-или компонентами. Такая концепция поддерживает групповую среду, 
где различные группы или индивидуумы используют различные подсистемы и компоненты. Кроме 
того, проект сложной сборки может быть легко разделен на отдельные задачи, которые будут 
назначены различным членам команды на ранних стадиях проектирования. 

Шесть Шагов Проектирования Сверху-Вниз 

• Определение назначения конструкции. 

• Определение предварительной структуры конструкции. 

• Использование скелетной модели. 

• Связывание назначения конструкции. 

• Непрерывное развитие сборки. 

• Управление взаимозависимостями деталей. 

Шаг 1 - Определение Назначения Конструкции 
Все изделия разрабатываются с некоторым предварительным планированием. Можно использовать 
эскизы, идеи, предложения и технические требования для определения цели, функций и конструкции 
изделия. Такое планирование помогает конструктору лучше понять изделие и начать конструировать 
систему и-или отдельный компонент. Конструктор может манипулировать этой информацией для 
определения структуры проекта и требований к индивидуальным компонентам в пределах 
Pro/ENGINEER. 

Шаг 2 - Определение Предварительной Структуры Изделия 
Структура изделия состоит из перечня компонентов и их иерархии в пределах сборки. Многие из 
главных подсистем, требуемых для проекта, будут определены при определении назначения 
конструкции. 



Pro/ENGINEER 2001 Базовый Курс    

- 192 - 

Структура изделия может быть легко создана в Pro/ENGINEER, позволяющем создание узлов и 
деталей без необходимости создания какой либо геометрии. Существующие узлы и детали также 
могут быть добавлены к структуре изделия без необходимости обязательной сборки. 

Определение предварительной структуры изделия помогает организовать конструкцию сборки в 
управляемые задачи, которые могут быть назначены командам конструкторов или отдельным 
проектировщикам. 

Шаг 3 - Скелетные Модели 
Скелетные модели действуют как трехмерная компоновка сборки и может использоваться для 
представления требований к размещению, важным посадочным местам и перемещению. Также, они 
могут использоваться для разделения информации о проекте между подсистемами и действовать как 
средство управления привязками (или взаимодействия) между этими подсистемами. Скелетные 
модели служат различным целям определения формы, согласования и функционирования сборки. 
Некоторые примеры: 

• Требования к пространству (форма / согласование). 

• Определение взаимодействия между компонентами (согласование). 

• Представление перемещения (функция) 

Шаг 4 - Связывание Назначения Конструкции 
Конструкторская информация высокого уровня типа критичных посадочных мест и требований к 
свободному пространству может быть размещена в скелетной модели сборки высокого уровня. Эта 
информация затем может быть распределена между соответствующими скелетными моделями 
подсборок. Это позволяет каждой подсборке содержать скелетную модель только с конструкторской 
информацией для этого узла. Это означает, что команда конструкторов узла может конфиденциально 
работать с собственным проектом, так как они имеют локальный доступ к проекту высокого уровня. 

Следовательно, различные конструкторские команды могут работать над собственными узлами и 
использовать одинаковую информацию высокого уровня по проекту. В результате, ведется 
параллельная работа над сборкой, которая первое время удовлетворяет требованиям. 

Рекомендуемый инструмент Pro/ENGINEER для сохранения назначения конструкции на различных 
уровнях структуры изделия - скелетная модель. Различный элементы, совместно использующие 
данные, типа Copy Geometry и Shrinkwrap могут использоваться для коммуникации и передачи 
назначения конструкции с уровня на уровень, и от модели до модели. 

Шаг 5 - Непрерывное Развитие Сборки 
Как только будет определено скелетное представление сборки и будут распределены критерии 
проекта высокого уровня, может быть начата работа над индивидуальными компонентами. 

Существует много методов заполнения структуры сборки конкретными деталями. Существующие 
компоненты могут быть собраны, или они могут быть созданы в контексте сборки. Такие отдельные 
детали могут быть связаны друг с другом, используя другие функциональные возможности, типа 
зависимостей сборки (assembly relations), скелетных моделей (skeleton models), компоновок (layouts) и 
элементов слияния (merge features) для последующего следования назначению конструкции. 

Шаг 6 - Управление Взаимозависимостями Деталей 
Одно из самых больших преимуществ параметрического моделирования � легкость изменения 
конструкции. Для управления взаимозависимостями между компонентами конструкции могут 
использоваться различные методы. Упорядоченные взаимозависимости позволяют использовать 
компоненты от одного проекта в другом и обеспечивают средства управления изменениями и 
обновления всей конструкции сборки. 
В Pro/ENGINEER существуют инструменты, помогающие пользователю настроить зависимости между 
деталями и узлами, которые будут проводить требуемые изменения на всех этапах проекта. Может 
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быть сконфигурировано управление привязками для ограничения нежелательных зависимостей и 
использование требуемых зависимостей. 
Кроме того, существует инструмент Глобального Просмотра Привязок, помогающий пользователям 
изучать и понимать существующие взаимозависимости между компонентами. 
Обратите внимание: 
По мере развития проекта конструкторы получают большее количество информации по нему и могут 
нуждаться в дальнейшем определении назначения конструкции, редактировать скелет, обмениваться 
критическими данными с другими моделями и продолжать наращивать сборки. 
В таком итеративном процессе конструкция становится более детальной и конкретной. Необходимо, 
поэтому, ожидать выполнения последовательности шагов, перечисленных выше, более одного раза 
для завершения проекта. 

Pro/ENGINEER Инструменты Проектирования Сверху-Вниз 

Следующие инструменты Pro/ENGINEER позволяют успешно достичь назначения конструкции, 
используя принцип конструирования сверху-вниз: 

Компоновки 
Компоновки (Layouts) - центральные положения, в которых можно выполнить негеометрические 
критерии конструирования сверху-вниз. Компоновка - особенно полезный инструмент в случаях, когда 
отсутствует точная информации по геометрии. Размеры, параметры и зависимости, определенные в 
Компоновке могут быть параметрически связаны со скелетными деталями или моделями. 

 
Рисунок 4: Компоновка Модели Гоночного Автомобиля 

 
Рисунок 5: Использование Компоновок в Качестве Инструмента Проектирования Сверху-Вниз 
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Скелетные Модели 
Скелеты - центральные положения, в которых можно геометрически обозначать главную 
конструктивную информацию по модели. Скелетные модели можно использовать для представления 
конструктивной информации в трехмерной компоновке. Существуют три типичных способа 
использования скелетов: 

• Требования к пространству (форма / согласование). 

 
Рисунок 6: Использование Скелетов для Высвобождения Места 

• Определение взаимодействия между компонентами (согласование). 

 
Рисунок 7: Использование Скелетов для Согласования 

• Представление перемещения (функция) 

 
Рисунок 8: Использование Скелетов для Представления Движения 

Элементы Совместного Использования Данных 
• Publish Geometry (Публикация Геометрии) � элемент Pro/ENGINEER, который позволяет 

конструктору документировать информацию по конструкции, облегчая другим помогая 
использовать функцию Copy Geometry (Копировать Геометрию) в последующем. 
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Рисунок 9: Диалоговое Окно Publish Geometry 

 

• Copy Geometry (Копировать Геометрию) � элемент Pro/ENGINEER, который позволяет 
передавать информацию по конструкции типа поверхностей, опорных плоскостей и опорных 
осей из одной модели в другую. 

 
Рисунок 10: Вызов Элемента Copy Geometry 

• Shrinkwrap - элемент Pro/ENGINEER, который позволяет �упаковывать� модель или сборку в 
виде поверхностей, значительно сокращая, таким образом, время регенерации модели. 
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Рисунок 11: Вызов Элементов Shrinkwrap 

Управление Привязками / Взаимозависимостями 
Две функции, помогающие пользователю в шестом текущем шаге проектирования сверху-вниз - 
Управление Привязками (Reference Control) и Глобальный Просмотр Привязок (Global Reference 
Viewer). 

Управление Привязками 
Диалоговое окно Reference Control позволяет пользователям определять допустимые пределы для 
привязок, создаваемых системой. Эта функция особенно полезна при проектировании в сборке, или 
при создании элементов Copy Geometry. 
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Рисунок 12: Диалоговое Окно Reference Control 

Глобальный Просмотр Привязок 

Глобальный Просмотр Привязок - очень мощный инструмент, позволяющий находить любой тип 
внешних привязок между моделями в сборке. Этот инструмент позволяет создавать только требуемые 
привязки или находить конфликты в существующих сборках. 
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Рисунок 13: Диалоговые Окна Глобального Просмотра Привязок и Просмотра Привязок Модели 

Резюме 

В этом модуле, Вы узнали что: 

• Конструирование сверху-вниз может начинаться, как непрерывный процесс обозначения, 
взаимодействия и управления конструкторской информацией. 

• Существуют шесть шагов в процессе проектирования Сверху-Вниз: Определение назначения 
конструкции, Определение предварительной структуры конструкции, Использование скелетной 
модели, Связывание назначения конструкции, Непрерывное развитие сборки, Управление 
взаимозависимостями деталей. 

• Инструменты Компоновки (Layout), Скелетных моделей (Skeleton), Публикуемой геометрии 
(Publish Geometry) и Копирования Геометрии (Copy Geometry) осуществляют принципы 
конструирования Сверху-Вниз. 

• Управление привязками и взаимодействием с использованием опций управления привязками 
и глобальный просмотр привязок являются важнейшей частью непрерывного цикла 
построения моделей с использованием принципов конструирования Сверху-Вниз. 
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Глава 15 

Дополнительные Опорные Элементы и Скелетные 
Модели 

Pro/ENGINEER позволяет создавать опорные элементы, отличные от опорных плоскостей. 
Эти дополнительные опорные элементы включают опорные оси, опорные кривые, 
опорные точки и опорные системы координат. 
В этой главе, Вы изучите, как они создаются и почему они должны использоваться. Кроме 
того, Вы изучите основы скелетных элементов и их использование. 

Цели 
В этой главе Вы изучите: 

• описание всех доступных дополнительных опорных элементов. 

• Создание дополнительных опорных элементов различными способами. 

• Примените дополнительные опорные элементы в качестве надежных привязок для 
твердотельной геометрии. 

• Создадите основные скелетные элементы. 

Дополнительные Опорные Элементы 

Опорные элементы � нетвердотельные элементы без массы, которые могут использоваться в 
качестве привязок и как родители для твердотельной геометрии. Все опорные элементы служат в 
качестве конструктивной геометрии. 

Опорные Оси 
Опорные оси отображаются в виде штрих-пунктирных желтых линий, которые, по умолчанию, имеют 
ярлычки-названия типа A_1, A_2 и A_3. 

Применение 
• В качестве центров отверстий. 

• В качестве привязок сборочных зависимостей. 

• В качестве вспомогательных объектов при создании других опорных элементов. 

Методы Создания 
• Thru Edge � создается вдоль прямой кромки модели. 

• Normal Pln � перпендикулярно выбранной поверхности с линейными размерами от двух 
привязок. 

• Pnt Norm Pln � перпендикулярно выбранной поверхности и через опорную точку. 
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• Thru Cyl � создается через «воображаемый» центр любой поверхности вращения. 

• Two Planes � создается в месте пересечения двух поверхностей. 

• Two Pnt/Vtx � создается через две опорные точки или две вершины модели. 

• Point on Surface � проходит через точку, перпендикулярно поверхности. 

• Tan Curve � создается касательно опорной кривой или в конечной точке кромки модели. 

Опорные Кривые 
Опорные кривые отображаются в модели в виде оранжевых линий. Они могут быть прямыми или 
искривленными, замкнутыми или разомкнутыми. 

Применение 
• В качестве траектории элементов протягивания. 

• Для вспомогательных целей при определении формы скелета сборки. 

• Для вспомогательных целей при создании поверхности. 

• Для измерения элементов модели. 

Методы Создания 
• Sketch � использует функциональные возможности Эскиза для создания кривой на плоской 

поверхности. 

• Intr. Surf � создает кривую в месте пересечения двух поверхностей. 

• Thru Points � создает кривую через набор опорных точек. 

• Projected � проецирует кривую на твердотельную поверхность. 

• Formed � переносит опорную кривую на поверхность в виде формованной кривой (formed 
curve). Формованная кривая сохраняет длину исходной кривой. 

• 2 Projection � создает проецируемую опорную кривую из двух сечений на непараллельных 
эскизных плоскостях. 

• From Equation � создает кривую на основе математических уравнений. 

Опорные Точки 
Опорные точки отображаются в виде небольших желтый крестиков "x" на модели с ярлычками-
названиями типа PNT1. 

Применение 
• Для вспомогательных целей при создании опорных кривых и опорных осей. 

• При создании отверстий, размещаемых по точке (on point). 
• В качестве привязки для сборочных зависимостей. 

Методы Создания 
• On Surface � создает точки на выбранной поверхности, используя линейные размеры по двум 

привязкам. 

• On Vertex � точка определяется в вершине твердотельной поверхности. 

• Offset Csys � точки определяются со смещением относительной координатной системы с 
использованием декартовых, цилиндрических или сферических координат. 
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• At Center � создает точки в центре дуги или окружности. 

• On Curve � создает точки вдоль опорной кривой или кромки модели со следующими 
размерными привязками: 

− Offset � размещает точку на смещенной кривой на расстоянии от планарной поверхности. 

− Length Ratio � размещает точку на кривой на расстоянии, выражаемом в виде процента 
от общей длины кривой ( 0.0 и 1.0 - начальная и конечная точки кривой). 

− Actual Length - размещает точку, используя фактическое расстояние длины дуги по 
кривой. 

− Field Point � Размещает свободно-плавающую точку на выбранной привязке, типа 
поверхности или кривой. 

Опорные Системы Координат 
Опорные системы координат отображаются на модели желтым цветом и обычно имеют ярлычки-
названия, типа CS1. Каждая ось на системе координат также имеет название (x, y, z). 

Применение 
• Возможность определения нулевого положения нулевого положения для точек, считываемых 

из файла. 

• Ориентация для целей обработки. 

• Привязка к сборочным зависимостям. 

Методы Создания 
• 3 Planes � нулевая точка находится в месте пересечения трех плоскостей. 

• Pnt + 2Axes � нулевая точка находится в опорной точке, вершине или нулевой точке другой 
системы координат. 

• 2 Axes � нулевая точка находится в месте пересечения двух осей, прямолинейных кромок или 
прямолинейных опорных кривых. 

• Default � нулевая точка находится в первой вершине базового элемента (base feature). 

Лабораторный Практикум 

Цель 
К концу этого практикума, Вы сможете создавать и использовать в твердотельном 
элементе все дополнительные опорные элементы, изученные в этом модуле. 

Метод 
Упражнение 1 начнется с опорных элементов и опорных систем координат по умолчанию, включенных 
в некоторую новую деталь. Затем будут созданы опорные точки и опорная кривая для создания 
дверной ручки. 

В Упражнении 2, будут использованы несколько опорных элементов для создания простого скелета. 

Инструменты 
ПИКТОГРАММА ОПИСАНИЕ 

   Вставляет опорную систему координат 
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    Вставляет опорные точки 

    Вставляет эскизную кривую 

    Вставляет опорную кривую 

    Вставляет опорную ось 

УПРАЖНЕНИЕ 1: Создание Дополнительных Опорных Элементов 
Задача 1. Создать новую деталь и определить контрольные точки для ручки. 

1. Создайте новую деталь с названием DOOR_HANDLE. 

Задача 2. Так как система координат уже имеется, мы создадим точки в положении х, y, z 
относительно нее. 

1. Щелкните по  [Вставляет опорные точки] в меню пиктограмм и щелкните по Offset Csys в меню 
DATUM POINT. 

2. выберите систему координат PRT_CSYS_DEF в дереве модели. 

3. Щелкните по Cartesian в качестве типа вводимых координат. 

4. Щелкните по Enter Points и введите [0] по x, [0] по y и [0] по z. 

Задача 3. Как только положения x, y, z первой опорной точки будут определены, введите данные х, y, 
z для других точек. 

1. Создайте вторую опорную точку с координатами 4,0,0. Введите [4], [0], [0] на запрос. 

2. Создайте третью опорную точку с координатами 4,16,0. Введите [4], [16], [0] на запрос. 

3. Создайте четвертую опорную точку с координатами 0,16,0. Введите [0], [16], [0] на запрос. 

4. Как только координаты последней точки будут введены, нажмите <ENTER> на пустой строке. 

5. Щелкните по Done для завершения элемента. Деталь должна выглядеть, как показано на 
следующем рисунке. 

 
Рисунок 1: Опорные Точки 

Задача 4. Создать опорную кривую через эти точки. Порядок создания точек имеет значение, потому 
что кривая соединит их в этом порядке. 

1. Щелкните по  [Вставка опорной кривой], щелкните по Thru Points > Done. 
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Задача 5. Определить указанный радиус, с которым кривая будет проходить через каждую точку. 

1. Щелкните по Single Rad, и выберите PNT1. Введите [1.0]. 

2. Щелкните по Done Sel > Done. 

3. Щелкните по ОК для завершения элемента. 

Задача 6. Создать элемент протягивания в виде геометрии дверной ручки. Траектория - созданная 
опорная кривая. 

1. Щелкните по Insert > Protrusion > Sweep. 

2. Щелкните по Select Traj > Curve Chain. 

3. выберите опорную кривую; затем щелкните по Select All > Done > Okay. 
4. Определите окружность диаметром 1.0 дюйма в качестве поперечного сечения с центром в точке 
пересечения осевых линий. 

5. Щелкните по ОК для завершения элемента. Завершенная деталь должна выглядеть, как показано 
на следующем рисунке. 

 
Рисунок 2: Завершенная Твердотельная Геометрия 

УПРАЖНЕНИЕ 2: Создание Простого Скелета 
Задача 7. Создать опорную кривую. 

1. Создайте новую деталь с именем LINK_SKEL, используя шаблон по умолчанию. 

2. выберите опорную плоскость FRONT и щелкните по  [Вставка эскизной опорной кривой]. 

3. Создайте эскиз следующих трех сегментов линии. 

 
Рисунок 3: Эскиз Трех Линий 

4. Щелкните по  > ОК. 

Задача 8. Создать точки в вершинах. 
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1. Щелкните по  [Вставка опорной точки] > On Vertex, затем выберите вершины, показанные 
ниже. 

 
Рисунок 4: Выбор Вершин 

Задача 9. Создать оси через точки. 

1. Щелкните по  [Вставка опорной оси] > Pnt Norm Pln и выберите опорную плоскость FRONT и 
PNT0. 

2. Щелкните по Pnt Norm Pln и выберите опорную плоскость FRONT и PNT1. 

3. Модель должна быть похожа на рисунок, представленный ниже. (Ярлычки точки и оси выключены 
для ясности) 

 
Рисунок 5: Эскизная Предварительная Модель 

Задача 10. Создать две дополнительных опорные плоскости 

1. Щелкните по  [Вставка опорной плоскости] > Though и выберите кривую, показанную на 
следующем рисунке. 

 
Рисунок 6: Создание Опорной Плоскости, Проходящей Через Элементы 

2. Щелкните по Parallel, выберите опорную плоскость RIGHT и щелкните по Done. 
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3. Щелкните по  > Though и выберите диагональную кривую. 

4. Щелкните по Normal, выберите опорную плоскость FRONT и щелкните по Done. 

Задача 11. Создать систему координат 

1. Щелкните по  [Вставка опорной системы координат] > Orig+Zaxis >. Затем, выберите вершину, 
показанную ниже. 

 
Рисунок 7: Выбор Вершины 

2. выберите DTM1 и ОК для принятия направления оси Z. 

3. Щелкните по Plane Norm, выберите опорный элемент FRONT и щелкните по Flip > Okay для 
принятия направления оси Y. 

 
Рисунок 8: Создание Перпендикулярной Плоскости 

4. Выключите отображение опорных плоскостей . 

5. выберите опорную кривую и щелкните по  > Modify. 

6. выберите размер 40.0, измените на [15.0] и выполните регенерацию. 

 
Рисунок 9: Регенерированная Модель 

7. Обратите внимание на обновление плоскостей, точек, осей и csys. 
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8. Верните размер общей высоты обратно к [40.0] и выполните Regenerate. 

УПРАЖНЕНИЕ 3: Связывание Скелета в Сборке 
Задача 1. Открыть и «изогнуть» сборку со скелетом. 

1. Откройте Link_Skel.asm и выключите отображение опорных элементов. 

 
Рисунок 10: Сборка Звеньев 

2. Обратите внимание, что LINK_SKEL (из последнего упражнения) была собрана в виде скелета в 
этой сборке. Три твердотельных модели были собраны в скелет. 

Задача 2. Проведение изменений в скелете. 

1. выберите Link_Skeleton из дерева модели и щелкните по  > Modify, затем выберите кривую, 
показанную ниже. 

 
Рисунок 11: Выбор Кривой для Изменения 

2. выберите размер 40.0, измените на [15.0] и выполните Regenerate > Automatic. 

 
Рисунок 12: Модель с Измененными Размерами 

3. Обратите внимание, что компоненты перемещаются вслед за скелетом. 

4. Измените размер общей высоты на [48.0] и выполните Regenerate > Automatic. 
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Рисунок 13: Модель с Последующими Изменениями в Размерах 

5. Сохраните модель и сотрите ее из оперативной памяти. 

УПРЖНЕНИЕ 4 (Необязательное): Кулиса 
Задача 1. Открыть частично законченную модель, состоящую из опорных элементов. Создать 
дополнительные элементы для завершения «скелета». 

1. Откройте VICE_GRIP.PRT. 

 
Рисунок 14: Исходная Модель 

2. выберите опорную плоскость FRONT и щелкните по . 

3. выберите две привязки по умолчанию и щелкните по Delete. 

4. Отобразите ТОЛЬКО оси и точки. 

5. выберите ось A_1 и две точки для привязок, как показано на следующем рисунке. 

 
Рисунок 15: Создание Привязок 

Задача 2. Сделайте эскиз следующей кривой. 

Обратите внимание: 
Если при создании эскиза возникают трудности, то можно открыть завершенную модель кулисы. 
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Рисунок 16: Эскиз Модели 

1. После завершения эскиза щелкните по  и выберите размер 45°. 

2. Увеличьте ползунок чувствительности до максимума и прокрутите колесико приблизительно между 
45° и 15°. Обратите внимание, как кривые работают вместе, сохраняя связь. Следующий рисунок 
имеет угол, измененный на 18°. 

 
Рисунок 17: Измененный Угол 

3. Эта «скелетная» модель теперь может использоваться для проектирования детали в процессе 
конструирования сверху-вниз, или модели могут быть непосредственно собранны для моделирования 
движения. 

4. Завершите элемент и сохраните модель. 

Резюме 

В этом модуле, Вы узнали это 
• Дополнительные опорные элементы являются удобными и гибкими элементами, 

помогающими в создании модели. 
• Опорные элементы не имеют массы и не являются твердотельными; поэтому они могут быть 

легко вставлены при создании твердотельной геометрии. 
• Опорные Оси создаются для всех типов элементов вращения, отверстий и выдавленных 

окружностей. 
• Опорные Кривые часто применяются при создании поверхностей с использованием 

функциональности Среды эскизирования. 
• Опорные Точки используются в качестве привязок для сборочных зависимостей и для 

размещения отверстий в точке (on point) в процессе их создания. 
• Опорные Системы Координат используются для ориентирования в процедурах обработки. 
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Глава 16 

Слои и Функция Подавления 

В этой главе Вы изучите, как использовать слои. Слои позволяют организовывать 
компоненты модели - элементы, опорные плоскости и детали � таким образом, что можно 
выполнять операции на всех этих объектах сразу. Типичные действия, которые могут 
выполняться над слоями, включают управление отображением, выбором, подавлением 
модели и т.д. 

Цели 
В этой главе Вы изучите: 

• создание слоев для данной модели 

• Связывание модели со слоем. 

• Управление статусом отображения слоя. 

• Управление данными с функциями подавления. 

• Переработка существующих отношений родитель/ребенок. 

• Восстановление подавленных элементов. 

Определение Слоев 

Функциональные Возможности 
• Слои предоставляют средство организации объектов в зависимые группы с целью 

упорядочивания. 

• Они позволяют выполнять некоторые коллективные операции с группами объектов, типа 
элементов детали, компонентов сборки, чертежных объектов рисунков и, даже, другими 
слоями. 

• Слои позволяют выполнять некоторые операции типа удаления, вывода на печать и 
подавления для некоторых элементов. 

Работа Со Слоями 
• При использовании шаблонов по умолчанию Pro/ENGINEER автоматически связывает 

различные элементы модели с конкретными слоями по умолчанию. 

• Дополнительные слои можно создавать двумя методами. Первый � при помощи 
конфигурационного файла, а второй - используя команду def layers в выпадающем Layer 
диалогового окна LAYERS. 

• Один и тот же элемент может быть связан с несколькими слоями. 

• Можно иметь столько слоев, сколько требуется, или не иметь ни одного. 
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Создание Слоев 

Выбор Объектов 
Активный объект - модель, в которой фактически создаются слои и проводятся изменения. Основная 
идея состоит в связывании со слоем тех объектов, которые существуют на уровне слоя. Например, 
если в качестве активного объекта выбрана сборка высокого уровня, то объекты сборки высокого 
уровня можно связывать только со слоем сборки высокого уровня. 

Обратите внимание: 
В режиме Рисунка, в качестве активной модели можно выбирать модель или рисунок. 

Создание Слоев 
• Pro/ENGINEER идентифицирует слои только по имени. 

• Имя слоя может содержать не более 31 буквенно-цифрового символа. 

• После установки активной модели можно определить новый слой щелчком по . 

• После ввода имени первого слоя можно создавать следующие слои путем ввода имени и 
нажатия <ENTER>. 

Связывание Объектов со Слоем 
После создания слоев, с ними можно связывать объекты, как автоматически, так и вручную. 

Например на следующем рисунке, можно привязать ось к новому слою автоматически, выбирая в 
Default Layer Types. Аналогично, другие типы элементов могут быть также связаны с тем же или с 
другим слоем. 

 
Рисунок 1: Диалоговое Окно New Layer 

Используя опции в диалоговом окне LAYER, можно связывать и удалять объекты с выбранных слоев 
вручную. Их можно копировать или переносить с одного слоя на другой. 
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Таблица 1: Типы Объектов 

Компонент 
(Только режим Сборки) 

Выберите детали и/или сборки. Щелкните по All Instances или 
Individual в меню LAYER COMP. 

Feature • Выберите следующие опции элементов в меню LAY FEAT. 

• Select � указывает конкретный элемент 

• Range � указывает диапазон элементов 

• All of Type � указывает тип элемента в меню ALL 
FEATURES. 

• Feat/Child � указывает элемент и всех его потомков 

Curve Выбирает опорную кривую 

Quilt Выбирает лоскутную поверхность 

2-D Items Выбирает объект рисунка 

Text Выбирает ярлычки-названия для опорных плоскостей, осей, точек 
и систем координат. Если текстовые ярлычки скрыты, щелкните по 
Sel By Menu или выберите из Дерева модели. 

Point Выбирает опорную точку 

Datum Plane Выбирает опорную плоскость 

Layer Выбирает слой. Создает иерархию слоев с подслоями. 

Solid Geometry Выбирает элемент. Скрывает все твердотельные элементы 
детали. 

Обратите внимание: 
При попытке связать объект со слоем, который не существует в активной модели, система опознает 
родственную модель (native model) для объекта. Можно выбирать или создавать слой в родственной 
модели, или игнорировать выбор этого объекта. 

Установка Состояния Отображения Слоя 
Одна из главных причин для организации объектов посредством слоев состоит в управлении 
семейством информации, которую система отображает на экране для конкретного объекта. Можно 
выполнять следующие процедуры, как показано на следующем рисунке: 

• отображать слои на экране. 

• Скрывать выбранные слои путем их удаления. 

• Обособлять выбранные слои путем отображения их на экране и удалением необособленных 
слоев с экрана. 

• Скрывать компоненты, связанные с выбранным слоем, путем отображения их всех в виде 
скрытых линий при работе в режиме Hidden Line, или удаления их с экрана при работе в 
режиме No Hidden (только в режиме Сборки). Статус отображения Hide не работает, если 
переменная среды установлена в Wireframe. 



Pro/ENGINEER 2001 Базовый Курс    

- 212 - 

 
Рисунок 2: Диалоговое Окно Layer Display 

Не все объекты слоев доступны для манипуляций в каждом режиме Pro/ENGINEER. 

Обратите внимание: 
Pro/ENGINEER не сохраняет статус отображения слоя по умолчанию при сохранении объекта. При 
следующем вызове объекта, состояние отображения возвращается в Show для всех слоев. Если 
требуется сохранить состояние отображения с объектом, необходимо щелкнуть по Save Status в 
диалоговом окне LAYER DISPLAY. 

Управление Состоянием Отображения Слоя 
В следующем рисунке слои создаются в режиме Part и Assembly, с ними связываются объекты и 
изменяется состояние отображения объектов. 

В режиме Детали, имеется выдавливание и три опорные плоскости. 

• Создайте слои PROT, DATUM_A и DATUM_B. 

• Свяжите выдавливание со слоем PROT. 

• Свяжите опорную плоскость А со слоем DATUM_А. 

•  Свяжите опорную плоскость В со слоем DATUM_В. 

• Опорную плоскость С не связывайте ни с каким слоем. 

В режиме Assembly, имеются три компонента (A, B и C) и две опорные плоскости сборки. 

• Создайте слои COMP_B, COMP_C и ADATUM_A. 

• Свяжите компонент В со слоем COMP_B. 

• Свяжите компонент С со слоем COMP_С. 

• Свяжите опорную плоскость сборки А со слоем АDATUM_А 

• Опорную плоскость сборки В и компонент А не связывайте ни с каким слоем. 
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Рисунок 3: Иллюстрация Статуса Отображения Слоя 

• A � все слои имеют статус отображения Shown (Отобразить). 
• B � PROT: Blank (Скрыт); DATUM_A: Shown (Отображен); DATUM_B: Blank (скрыт) 

• C � PROT: Shown (Отображен); DATUM_A: Shown (Отображен); DATUM_B: Isolate 

• D � все слои имеют статус отображения Show (Отображен). 

• E � COMP_B: Blank (Скрыт); COMP_C: Show (Отображен); ADATUM_A: Blank (Скрыт) 

• F � COMP_B: Isolate (Изолирован); COMP_C: Show (Отображен); ADATUM_A: Show 
(Отображен) 

Функциональные Возможности Подавления 

• Подавление временно удаляет элемент или компонент из модели. 

• Система не регенерирует объект, и модель отображается так, как если бы объекта никогда не 
существовало. 

• При подавлении объекта его можно восстановить. Подавление отличается от удаления тем, 
что оно имеет временный характер. 

Применение Функции Подавления 
• Для упрощения модели. 

• Для сокращения времени регенерации. 

• Для сокращения времени перерисовки экрана. 

• Для использования альтернативных вариантов при конструировании. 

Подавление Отношений Родитель / Потомок 
При подавлении элемента или компонента, который имеет не подавленных потомков, Pro/ENGINEER 
требует выполнить одно из следующего: 
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• перенаправить привязки потомков. 

• Изменить схему образмеривания потомка. 

• Подавить потомка. 

• Приостановить операции на потомке до момента регенерации модели. 

• Заморозить компонент (только в режиме Сборки). 

Сохранение и Возобновление Подавленных Элементов 
Можно сохранять модель с подавленными элементами и-или компонентами. При ее вызове или 
регенерации, Pro/ENGINEER сообщает о наличии подавленных объектов. 

При вызове или регенерации подавленных элементов, система возвращает их в исходное 
местоположение в списке элементов. Можно восстанавливать их путем выбора из окна Дерева 
модели или, используя одну из следующих опций в меню RESUME: 

• All � восстанавливает все подавленные элементы. 

• Layer � восстанавливает объекты по слою. 

• Last Set � восстанавливает последнюю группу подавленных элементов. 

• Feat ID � восстанавливает объекты по указанию их ID. 

Лабораторный Практикум 

Цель 
Этот практикум предназначен для иллюстрации практического применение функций слоев 
и подавления. 

Метод 
В Упражнениях 1 и 2, Вы научитесь управлять информацией, которую система отображает в модели 
детали и модели сборки. Вы научитесь использовать слои для управления отображением опорных 
плоскостей и осей детали из Упражнения 1, в противоположность выключению их отображения. 
В Упражнении 3, Вы подавите элемент в детали. 
В Упражнении 4, Вы поэкспериментируете с подавлением компонента сборки. 

Инструменты 
ПИКТОГРАММА ОПИСАНИЕ 

   Список сохраненных видов 

   Создает слои 

   Добавляет объект к выбранному слою 

    Скрытые слои 

    Отображаемые слои 

    Выбрать все 

    Отменить выбор всех объектов 
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УПРАЖНЕНИЕ 1: Использование Слоев в Режиме Детали 

 
Рисунок 4: Слой Детали Кривошипа 

Задача 1. Выполнить регенерацию детали кривошипа; затем закрасить и повернуть модель. 

1. Измените рабочий каталог на LAYER_SUPPRESS 

2. Щелкните по  [Открыть файл] и откройте LAYER_CRANK.PRT. 

3. Закрасьте модель, если она еще не закрашена. 

Задача 2. Создать два слоя с именами DATUMS и AXES. 

1. Щелкните по  [Список сохраненных видов]. В списке присутствует только один вид Default. 

2. Щелкните по View > Layers и щелкните по  [Создать слои]. 

3. Введите [DATUMS], затем щелкните по Add. 

4. Введите [AXES], затем щелкните по OK. 

Задача 3. Связать опорные плоскости по умолчанию с опорным слоем. 

1. выберите слой Datums из списка слоев. Слой Axes не должен быть подсвечен. 

2. Щелкните по  [Добавить объект к выбранному слою]. 

3. Щелкните по Datum Plane в меню LAYER OBJ. 

4. выберите DTM1, DTM2 и DTM3 в Дереве модели, затем � щелкните по Done Sel > Done/Return. 

Задача 4. Связать оси детали со слоем осей. 

1. Снимите выбор со слоя Datums и выберите слой Axes. 

2. Щелкните по пиктограмме  и щелкните по Feature в меню LAYER OBJ. 

3. Щелкните по Query Sel. выберите A_1 бобышки. Подтвердите выбор. 

4. Теперь выберите A_5 и отверстие, пересекающее бобышку. Подтвердите выбор. 

5. Щелкните по Query Sel. выберите ось A_2. Подтвердите выбор. 

6. Щелкните по Done Sel > Done/Return. 

Задача 5. Использовать диалоговое окно LAYER для отображения элементов, связанных со слоями. 

1. Щелкните по Show > Layer Items. 
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2. Tree > Expand >All. 
Задача 6. Изменить статус отображения только что созданных двух слоев. 

1. Щелкните по Axes и Datums в диалоговом окне LAYERS. 

2. Щелкните по , затем щелкните по . 

3. Система больше не отображает опорные плоскости и оси на экране, но они все еще существуют. 
Это можно проверить, используя Дерево модели. 

4. Закройте диалоговое окно LAYERS. 

5. Сохраните модель и закройте окно 

Обратите внимание: 
Pro/ENGINEER не сохраняет состояние отображения слоев, если не будет выбрана опция Save Status 
до выхода из диалогового окна LAYERS. 

 
Рисунок 5: Статус Отображения Слоя Установлен в Blank (Скрыть) 

УПРАЖНЕНИЕ 2: Использование Слоев в Режиме Сборки 

 
Рисунок 6: Слои Сборки 

Задача 1. Открыть существующую сборку и определить два слоя в сборке верхнего уровня с именами 
crank и gear. 

1. Откройте PINION.ASM. 
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2. Щелкните по View > Layers и щелкните по  [Создать слой]. 

3. Введите [CRANK] и нажмите <ENTER>. 

4. Введите [GEAR], затем щелкните по OK. 

Задача 2. Связать деталь кривошипа со слоем CRANK, а шестерню со слоем GEAR. 

1. Снимите выделение со слоя GEAR и выберите слой CRANK. 

2. Щелкните по . 

3. Щелкните по Component в меню LAYER OBJ. 

4. Щелкните по Individual в меню LAYER COMP. 

5. Щелкните по Sel By Menu, затем выберите LAYER_CRANK.PRT. 
6. Завершите связывание. Щелкните по Done Sel > Done/Return > Done/Return. 
7. Повторите вышеописанные шаги для связывания детали шестерни со слоем шестерни 

Задача 3. Скрыть слои кривошипа и шестерни. 

1. выберите слои шестерни и кривошипа. 

2. Щелкните по  [Скрыть слои]. 

3. Перерисуйте экран и выключите опорные плоскости и оси. 

4. Система теперь не отображает компоненты слоев кривошипа и шестерни на экране. 

 
Рисунок 7: Слои Скрыты 

Задача 4. Проверить, что компоненты все еще существуют. 

1. Щелкните по Info > Feature List. 
2. Щелкните по Top Level > Apply. 

3. Прочитайте содержимое информационного окна и закройте информационное окно и диалоговое 
окно FEATURE LIST. 

Задача 5. Установить модель шестерни в режим отображения скрытых линий. 

1. Щелкните по  [Скрытые линии]. 

2. Щелкните по View > Layers. 

3. Щелкните по Gear в диалоговом окне LAYERS. 

4. Щелкните по  в диалоговом окне LAYERS. 

5. Перерисуйте экран. Система снова отображает компонент на экране. 
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Задача 6. Определить воздействие, которое другие переменные среды оказывают на установку 
Hidden Line для слоя. 

1. Щелкните по . 

 
Рисунок 8: Режим Отображения Hidden Line 

2. Щелкните по  в меню пиктограмм. 

 
Рисунок 9: Режим Отображения No Hidden 

Обратите внимание: 
Пиктограммы рядом с названиями слоев в диалоговом окне обозначают текущее состояние слоев. 

Если пиктограмма  [Отобразить слои] рядом с названием слоя - серая, значит некоторые из слоев 
с тем же названием в подсборках имеют различные состояний отображения 

Задача 7. Определить статус слоя опорных элементов. 

1. В диалоговом окне LAYERS. 

2. Щелкните по Show > Layer Items. 

3. Распахните слои опорных элементов. Щелкните по пиктограмме +  рядом с DATUMS. 
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4. Обратите внимание, что все модели имеют слой с именем DATUMS , но только некоторые из них - 
скрыты. 
Задача 8. Установитье оба слоя обратно в Shown. 

1. Щелкните по пиктограмме  [Выбрать все] в диалоговом окне LAYERS. 

2. Щелкните по . 
3. Перерисуйте экран. 
4. Все компоненты и их опорные плоскости должны быть снова видимы. Если опорные плоскости и оси 
не видны, проверьте пиктограммы среды в меню пиктограмм, 
Задача 9. Имеется возможность воздействовать как на отображение слоев в пределах всех уровней 
сборки, так и на объекты любого уровня. Измените отображение всех опорных плоскостей уровня 
детали. 

1. Щелкните по  [Снять выделение со всего]. 
2. выберите все вхождения под Datums, за исключением IN_LAYER_BASE.ASM. 

3. Щелкните по . 
4. Перерисуйте экран. Система больше не отображает опорные плоскости деталей на экране, но 
продолжает отображать опорные плоскости сборки. 
Задача 10. Добавить слой с именем Datums на верхнем уровне и связать опорные плоскости сборки 
по умолчанию. 

1. Щелкните по . 
2. Введите [asm_datums], затем щелкните по ОК. 

3. выберите опорные объекты слоя и щелкните по . 
4. выберите три опорные плоскости уровня сборки в PINION.ASM. 
5. Завершите связывание. Щелкните по Done Sel, затем щелкните по Done/Return в меню LAYER 
OBJ. 
Задача 11. Сохранить состояние отображения опорных плоскостей для следующего вызова сборки, 
или любого из связанных компонентов, 
1. Щелкните по Save Status в диалоговом окне LAYERS. 
2. Щелкните по Close. 
3. Сохраните сборку. 
4. Сотрите сборку и все связанные объекты из памяти. 

 
Рисунок 10: Опорные Плоскости По умолчанию Верхнего Уровня 
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УПРАЖНЕНИЕ 3: Подавление в Режиме Детали 
В этом упражнении, Вы подавите элемент для облегчения вызова и регенерации детали. 

На следующем рисунке, каждое отверстие имеет вырез, представляющий резьбу; поэтому, требуется 
много времени для ее вызова и регенерации. В нашем случае резьба требуется только для масс-
инерционных характеристик, но не для других операций. 

 
Рисунок 11: PLATE.PRT с Резьбой 

Задача 1. Изменить круговое выдавливание, которое в списке регенерации модели находится перед 
резьбой. 

1. Откройте деталь по имени PLATE.PRT, обратите внимание на количество времени, которое 
требуется системе для регенерации детали. 

2. Измените высоту круглой бобышки на 10мм. Щелкните по Modify и выберите бобышку. выберите 
размер 5 и введите [10]. 

3. Регенерируйте деталь. Обратите внимание на количество времени, которое требуется системе для 
обновления геометрии. 

Задача 2. Подавите сложный вырез резьбы. 

1. Щелкните по Feature > Suppress в менеджере меню. 

2. выберите массив вырезов в Дереве модели. 

3. Щелкните по Done Sel в меню GET SELECT. Щелкните по Done в меню SELECT FEAT. 

4. Обратите внимание, что вырез теперь отсутствует в модели. 

Задача 3. Как только элемент будет подавлен, Pro/ENGINEER не обрабатывает его в модели. 
Проверьте скорость, с которой система регенерирует модель без резьбы. 

1. Щелкните по Done в меню FEAT. 

2. Верните высоту бобышки обратно к 5. Щелкните по Modify и выберите размер 10, затем введите [5]. 

3. Регенерируйте деталь. Обратите внимание, что система теперь обновляет модель намного 
быстрее. 

4. Сохраните модель и сотрите ее из оперативной памяти. 

 
Рисунок 12: Подавленные Вырезы Резьбы 
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УПРАЖНЕНИЕ 4: Подавление Компонентов в Режиме Сборки 

 
Рисунок 13: Дополнительные Компоненты 

Задача 1. Подавить компоненты кривошипа в сборке, чтобы увидеть на что будет похожа сборка с 
другим кривошипом. 

1. Откройте SECOND_PINION.ASM, 

2. Щелкните по Component в меню ASSEMBLY. Щелкните по Suppress и выберите деталь 
кривошипа. 

3. Щелкните по Done Sel > Done. Обратите внимание, что система больше не отображает компонент в 
сборке. 

Задача 2. Можно собирать в сборке различные компоненты, чтобы проверить их совместимость с 
конструкцией сборки. Соберите модель, чтобы заменить кривошип. 

1. Щелкните по Component > Assemble и дважды щелкните по HAND_CRANK.PRT 

2. Щелкните по Align в выпадающем списке зависимостей в диалоговом окне COMPONENT 
PLACEMENT. 

3. выберите ось A_1 рукоятки. 

4. выберите ось A_1 вала. 

 
Рисунок 14: Выровненные Оси 
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5. выберите Align для второй зависимости. 

6. выберите ось A_5 рукоятки. 

7. выберите ось A_3 вала. 

8. Завершите размещение. 

9. Прочитайте сообщение в нижней области, затем щелкните по ОК. 

10. Закройте диалоговое окно COMPONENT PLACEMENT. 

Задача 3. Подавить модель рукоятки. 

1. Щелкните по Suppress. 

2. выберите HAND_CRANK, используя Дерево модели. 

3. Щелкните по Done в меню SELECT FEAT для завершения операции. 

Задача 4. Наложите зависимости между кривошипом зубчатого колеса и концом вала. 

1. Щелкните по Assemble и дважды щелкните по WHEEL_CRANK.PRT 

2. Щелкните по Align в выпадающем списке CONSTRAINT TYPE. 

3. Совместите ось A_1 кривошипа зубчатого колеса с осью A_1 вала. 

4. Совместите ось A_5 кривошипа зубчатого колеса с осью A_3 вала. 

5. Завершите размещение компонентов. 

Задача 5. Используя подавленные компоненты, можно легко переключаться между представлениями 
сборки для проверки, которая из них является наиболее подходящей. Подавите третью модель 
кривошипа и возобновите исходную. 

1. Подавите компонент кривошипа зубчатого колеса. Щелкните по Suppress и выберите кривошип 
зубчатого колеса. Щелкните по Done в меню SELECT FEAT. 

2. Выведите список подавленных компонентов в Дереве модели. Щелкните по View > Model Tree 
Setup > Item Display. 

3. выберите Suppressed Objects и щелкните по ОК. 

4. Восстановите слой исходного компонента кривошипа. Щелкните правой кнопкой мыши по записи 
LAYER_CRANK.PRT в Дереве модели и выберите Resume из выпадающего меню. 

Задача 6. Подавление временно удаляет компонент из сборки. Подавленная модель остается 
связанной со сборкой. Восстановите компоненты; затем поочередно удалите их из сборки. 

1. В МЕНЕДЖЕРЕ МЕНЮ щелкните по Component > Resume > All > Done 

2. Щелкните по Delete > Clip. 

3. выберите только деталь рукоятки из Дерева модели. 

4. Щелкните по Done Sel > Done. 

Совет: 
Для удаления подавленных элементов или компонентов можно использовать Дерево модели без 
предварительного их восстановления. 

5. Сохраните модель и сотрите ее из оперативной памяти. 

6. Изменить рабочий каталог обратно на INTRO_PROE_300. 
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Резюме 

В этом модуле, Вы узнали что: 

• Элемент Слои увеличивает гибкость при обработке моделей и упорядочивает объекты. 

• Объекты преднамеренно связываются с конкретным слоем модели. 

• Может быть создано любое количество слоев. 

• Статус отображения слоя может быть установлен в Hidden. 

• Подавление элементов в детали и компонентов в модели делает конструкцию более 
удобоуправляемой. 

• Подавленные элементы могут воздействовать на зависимости родитель/потомок. 

• Подавленные элементы могут быть восстановлены. 
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Глава 17 

Создание Поверхностей Свободной Формы 

Интерактивное Конструирование Поверхностей в Pro/ENGINEER (также называемое ISDX 
(Interactive Surface Design)) позволяет использовать новые элементы при моделировании 
поверхностей Pro/ENGINEER. В этом модуле Вы изучите некоторые способы использования 
ISDX, включая знакомство с элементом Стиль (Style). 

Цели 
В этой главе Вы изучите: 

• описание возможностей ISDX. 

• Использование новой парадигмы гибридного моделирования. 

• Инструментальные средства и меню создания элементов Стиль. 

• Использование одно- и четырехоконной компоновки. 

• Использование двух- и трехмерных кривых свободной формы. 

• Создание поверхностей свободной формы при помощи граничных кривых. 

Методы Конструирования с Интерактивными Поверхностями 

ISDX предлагает сплайн-ориентированный моделлер свободной формы, который позволяет 
создавать двух- и трехмерные кривые и поверхности свободной формы. ISDX можно использовать 
для создания поверхностных моделей свободной формы для: 

• концептуального дизайна. 

• Технического конструирования. 

• Обратного прототипирования (Reverse styling) 

ISDX позволяет создавать элементы СТИЛЯ (STYLE). При помощи элемента Стиля, можно легко 
создавать кривые и поверхности свободной формы. На следующем рисунке показаны некоторые 
примеры моделей, созданных при помощи элементов Стиля. 
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Рисунок 1: Примеры 

Элемент Стиля 

Элемент Стиля может содержать несколько кривых и поверхностей или лоскутных поверхностей. Он 
отображается в Дереве модели как Style. 

 
Рисунок 2: Элемент Стиля в Дереве модели 

 
Рисунок 3: Элемент Стиля, Содержащий Несколько Кривых и Поверхностей 

Элемент Стиля открывается в новой среде моделирования в одно- или четырехоконной компоновке с 
четырьмя видами. 
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Рисунок 4: Четырехоконная Компоновка 

Важные Концепции Элементов Стиля 
Ниже приведены важные концепции элементов Стиля: 

• Четырехоконная Компоновка � позволяет одновременно работать с несколькими видами 
модели. 

• Технология «гибкой» точки � позволяет привязывать кривую к другому элементу при помощи 
«гибкой» точки, которая может быть интерактивно размещена в требуемом месте. 

• Переключение Отношений Родитель/Потомок � Стиль предлагает гибкую иерархию 
создаваемых кривых и поверхностей. Здесь можно выбирать отношения родитель/потомок. 

Гибридное Моделирование 

Большинство изделий являются комбинацией геометрических и свободных форм. Стиль предлагает 
уникальную ситуацию, где можно объединять традиционные методы элементно-ориентированного 
параметрического моделирования Pro/ENGINEER с методами создания несвязанных поверхностей 
свободной формы. Можно создавать кривые и поверхности свободной формы, которые могут 
ссылаться на другие геометрические элементы. 

Любое изменение в параметрической модели регенерирует элементы Стиля, позволяя свободно 
смешивать несвязанные поверхности свободной формы с геометрическими параметрическими 
поверхностями. 

Такая уникальная ситуация также позволяет выполнять весь проект изделия в единой среде 
моделирования. 

Создание Поверхностей При Помощи ISDX 

ISDX можно использовать для создания кривых и поверхностей свободной формы, где геометрия 
либо не определена или требует большей гибкости. Также, эти возможности можно использовать, 
когда назначение конструкции зависит от визуальных или эстетических критериев. 

В частности, ISDX можно использовать для создания: 

• двух- и трехмерных кривых (с или без привязок). 

• Кривых На Поверхности (Curves On Surface (COS)). 
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• Для художественного конструирования моделей. 

• Поверхностей сопряжения и перехода. 

• Поверхностей свободной формы совместно с параметрическими поверхностями в технических 
моделях. 

• Поверхностях обратного прототипирования. 

Создание Двух- и Трехмерных Кривых 
Можно использовать Стиль в качестве двух- и трехмерного эскиза для создания несвязанных или 
привязанных кривых. Эти кривые могут быть присоединены к элементам типа точек, кривых или 
кромок и т.д., и могут использоваться для создания Стиля или других элементов Pro/ENGINEER. 

 
Рисунок 5: Определение Кривых в Трехмерном Пространстве 

 
Рисунок 6: Поверхность Сопряжения, Базирующаяся на Трехмерной Кривой Свободной Формы 

 
Рисунок 7: Поверхности, Созданные по Трехмерным Кривым 
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Использование COS 
Кривые на Поверхности (COS) можно создавать, эскизируя их непосредственно на базовой 
поверхности или, используя инструмент Проецирования. Стиль позволяет легко манипулировать или 
модифицировать COS для передачи назначения конструкции. COS можно использовать для 
построения последующих поверхностей или их обрезки. 

 
Рисунок 8: Использование COS для Обрезки 

Художественное Конструирование Моделей 
Можно использовать интуитивные кривые и поверхности свободной формы для выражения концепции 
изделия. Уникальная возможность интеграции параметрических поверхностей с поверхностями 
свободной формы дает возможность выполнить конструкцию изделия на единственной платформе и 
базе данных. Концептуализация в ISDX осуществляет доступ внутрь технических компонентов 
непосредственно в той же самой детали или сборке при проектировании внешних контуров тела. 

Также, можно моделировать, используя концептуальные изображения, которые могут применяться на 
базовых поверхностях, как показано на следующем рисунке. 

 

 
Рисунок 9: (A) Эскиз (B) Эскиз, Наложенный на Базовую Поверхность (C) Модель, Разработанная с 

Использованием Эскиза 

Создание Поверхностей Свободной Формы с Параметрическими Функциями 
В процессе конструирования изделий могут потребоваться размерные привязки на поверхности 
свободной формы. ISDX позволяет привязывать кривые и поверхности свободной формы к 
параметрическим кривым или поверхностям, давая возможность управлять поверхностями свободной 
формы при помощи размеров. 
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Рисунок 10: Размерное Управление Художественной Моделью 

Создание Сопряжений и Переходов 
Стиль можно использовать для быстрого создания высококачественных сплайновых сопряжений для 
улучшения эстетики или гладкости изделий. Можно создавать касательные поверхности или 
поверхности с касательной или непрерывной кривизной перехода с интерактивным контролем 
касания. 

 
Рисунок 11: Типичные Поверхности Перехода 

 
Рисунок 12: Интерактивная Манипуляция Касанием 

Применение Художественных Поверхностей при Разработке Моделей 
Художественные поверхности можно комбинировать с параметрическими поверхностями при 
создании поверхностей перехода или поверхностей с высокой кривизной. 
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Рисунок 13: Поверхности Перехода с Высокой Кривизной 

Обратное Прототипирование 
Можно удобно привязываться к импортированным сканированным кривым и фасеточным или 
поверхностным данным для построения художественных кривых и поверхностей. 

 
Рисунок 14: Обратное Прототипирование 

Среда Художественного Моделирования 

Pro/ENGINEER предлагает специальную среду моделирования при создании элементов Стиля. Она 
включает различные выпадающие меню, меню быстрого вызова, меню пиктограмм и другие средства 
для переключения в четырехоконную компоновку. Также можно активизировать некоторые 
специфичные меню, которые не доступны при создании других элементов Pro/ENGINEER. 

Меню и Пиктограммы 
Как показано на следующем рисунке, к главному меню добавляется меню STYLING, а также многие 
дополнительные команды к стандартным меню.  

 
Рисунок 15: Интерфейс Среды Художественного Моделирования 
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Виды и Плоскости 

Компоновка с Единственным Видом 
Компоновка с единственным видом позволяет создавать геометрию, используя единственный 
трехмерный вид или сохраненные ортогональные виды. 

Компоновка с Четырьмя Видами 
Компоновка с четырьмя видами отображает четыре ортогональных окна. Такая компоновка особенно 
полезна при создании и управлении трехмерными кривыми. 

 
Рисунок 16: Компоновка с Четырьмя Видами: Ориентация По умолчанию 

Активная Плоскость 
При определении кривых в Стиле, точки проецируются на текущую опорную плоскость, называемую 
активной плоскостью. По умолчанию, Стиль назначает плоскость Тор активной плоскостью. 

Зумирование, Панорамирование или Вращение Видов 
В однооконной компоновке вида, можно зумировать, панорамировать или вращать виды, используя 
обычные меню и команды Pro/ENGINEER. При четырехоконной компоновке, на выбранное окно 
необходимо поместить курсор и использовать стандартные команды зумирования, панорамирования 
или вращения. 

Создание Геометрии Стиля 

Кривые 
Элементы Стиля позволяют создавать сплайновые кривые и поверхности, построенные по кривым. 

Типы Кривых 
• Free � кривая, лежащая в трехмерном пространстве. 

• Planar � кривая, лежащая на указанной плоскости. 

• COS (Кривая На Поверхности) � кривая, привязанная к указанной поверхности. 
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Создание Кривых 
Для создания новой кривой, необходимо определить точки кривой. Щелкните левой кнопкой мыши для 
определения местоположений точек и щелкните средней кнопкой мыши для завершения текущей 
кривой и начала новой. 

Создание Двухмерных Кривых Свободной Формы 
Двухмерную кривую свободной формы можно создать, указывая точки на активной плоскости в окне с 
одним видом. 

 
Рисунок 17: 2-Двухмерная Кривая 

При четырехоконной компоновке, можно определять точки в одном виде и, затем, указать 
местоположение всей кривой в одном из двух оставшихся окон. 

 
Рисунок 18 

Обратите внимание: 
При определении точки, можно, удерживая кнопку мыши, перетаскивать ее в требуемое 
местоположение. 

Создание Трехмерных Кривых 
Трехмерные кривые можно создавать: 

• Определяя двухмерную кривую и, затем, перенося ее по третьей координате. 

• Определяя трехмерную кривую, указывая точки, как минимум, в двух окнах при 
четырехоконной компоновке. 

• Привязываясь к трехмерной геометрии. 
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Рисунок 19: Управление Двухмерной Кривой для превращения ее в Трехмерную 

 
Рисунок 20: Создание Трехмерной Кривой с Использованием Четырехоконной Компоновки 

Создание Плоских Кривых 
Для создания плоской кривой, необходимо выбрать опцию Planar в диалоговом окне CURVE. Плоская 
кривая создается на активной плоскости. 

 
Рисунок 21: Плоская Кривая, Находящаяся на Плоскости Right 

Редактирование Кривых 
Формой кривой можно управлять при помощи: 

• изменения положения промежуточных и конечных точек. 
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• Управления вектором, касательным в конечной точке. 

• Добавления и удаления точек. 

• Удлинения кривых. 

• Разделения или комбинирования кривых. 

Диалоговое окно CURVE содержит все опции для создания и управления формой кривой. 

 
Рисунок 22: Диалоговое Окно CURVE 

Наложение Зависимости на Перемещение Точки 
По умолчанию, неприсоединенные точки перемещаются свободно. На перемещение можно 
накладывать зависимости, используя опции в диалоговом окне CURVE EDIT: 

• Free (Свободно) � по умолчанию 

• Horizontal / Vertical (По горизонтали / Вертикали) 

• Normal (По Нормали) 

Однако, можно также использовать макрокоманды для привязки перемещения и сохранения опции 
диалогового окна на Free. 

Редактирование Гибких Точек 
При перемещении присоединенной точки или гибкой точки (soft point), она перемещается по элементу, 
к которому присоединена. Гибкую точку можно перемещать вдоль геометрии, к которой она 
привязана, в процессе редактирования кривой. 

 
Рисунок 23: Скольжение Гибкой Точки 

Редактирование Касательных 
Стиль позволяет манипулировать длиной и направлением касательной в конечной точке. Эти 
касательные можно использовать для изменения формы кривой или для наложения зависимостей. 
Для отображения касательной в конечной точке, необходимо щелкнуть по конечной точке, затем 
перетащить линию касательной для изменения длины или угла. 

 
Рисунок 24: Изменение Формы Кривой при Помощи Касательных 
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Создание Художественных Поверхностей 

Художественные поверхности можно создавать, используя любые четыре соприкасающиеся границы. 
Для этих целей могут быть использованы, кривые Стиля, опорные кривые и кромки, как показано на 
следующем рисунке 

 
Рисунок 25: Художественные Поверхности по Четырем Соприкасающимся Границам 

Лабораторный Практикум 

Цель 
К концу этого практикума, Вы научитесь эффективно использовать интерфейс Стиля и 
создадите простые художественные поверхности. 

Метод 
В Упражнении 1, Вы переопределите элемент Стиля, созданный в модели PDA. Вы воспользуетесь 
меню, меню быстрого вызова и меню пиктограмм, а также установите различные ориентации вида. 

В Упражнении 2, Вы создадите поверхности детали прожектора, соединяя четыре границы кривой 
Стиля. 

Инструменты 
ПИКТОГРАММА ОПИСАНИЕ 

   Устанавливает активную опорную плоскость 

   Создает и редактирует кривые 

   Отображает диаграмму кривизны 

   Стирает все точки кривизны 

    Выполняет общую регенерацию 

    Создает поверхности по граничным кривым 

УПРАЖНЕНИЕ 1: Изучение Интерфейса СТИЛЯ 
Задача 1. Поэкспериментировать с существующим элементом Стиля. 

1. Установите рабочий каталог в ISDX. 

2. Откройте PALM.PRT. 
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Рисунок 26: Исходная Модель 

Обратите внимание: 
«LCD экран» фактически является изображением *.jpg, наложенным на модель Pro/E в виде текстуры. 

3. В Дереве модели, щелкните по STYLE id 89 и щелкните по  > Redefine. 

4. Обратите внимание на рабочую среду Стиля и, особенно, на новые инструменты, появившиеся в 
интерфейсе, как показано на следующем рисунке. 

 
Рисунок 27: Инструментальные Меню Стиля 

5. Сетка, отображаемая на плоскости ТОР, указывает, что Тор установлена в качестве активной 
плоскости. 

6. Щелкните по View > Active Plane Orientation. Плоскость ТОР устанавливается параллельно экрану. 

7. В окне, щелкните по  > Default Orientation. 

Задача 2. Изменить расположение окон. 

1. Щелкните по View > Show All. 
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2. Щелкните по Styling > Set Active Plane. выберите плоскость Oblique из Дерева модели. 

3. В верхнем левом окне щелкните по  > Active Plane Orientation в выпадающем меню. 

4. Выполните вращение модели в любом окне. 

5. Щелкните по View > Default Orientation для восстановления изображения во всех окнах. 

6. Щелкните в любом окне, затем  > Show All. 
7. Восстановите активную плоскость. По правой кнопке мыши выберите Set Active Plane и выберите 
плоскость ТОР. 

8. Нажмите <CNTRL> + <D> для восстановления ориентации по умолчанию. 

Задача 3. Познакомьтесь с предустановками Стиля. 

1. Щелкните по  и . 

2. Щелкните по Utilities > Styling Preferences. 

3. Измените шаг сетки. В области сетки диалогового окна введите [15] и нажмите <ENTER>. 

 
Рисунок 28: Изменение Шага Сетки 

4. В области Display диалогового окна STYLING PREFERENCES, снимите переключатель Grid. 

5. В области Surface Mesh, переместите ползунок quality направо, чтобы сетка стала более плотной. 

6. Щелкните по  [Закраска]. 

7. В области surface mesh, щелкните по On для отображения сетки на закрашенной модели. 

 
Рисунок 29: Отображение Сетки на Закрашенной Модели 
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8. Отобразите модель без кривой и сетки. Щелкните по View > Shade. 
9. Закройте диалоговое окно STYLING PREFERENCES. 

10. Щелкните по  [Перерисовать]. 

Задача 4. Познакомьтесь с процедурой выбора. 

1. Щелкните возле набора кривых, как показано на следующем рисунке. 

 
Рисунок 30: Выбор Кривой 

2. Щелкните по  > Next для перебора команд в выпадающем меню. 

3. выберите объекты из набора. Щелкните правой кнопкой мыши по Show Sel Bin. В диалоговом окне 
SELECTION, щелкните по Style: (1) Curve:CF-116. 

4. Завершите элемент Стиля, щелкните по . 

5. Закройте модель. 

УПРАЖНЕНИЕ 2: Создание Поверхности Стиля 
Задача 1. Начать новый элемент Стиля для тела прожектора. 

1. Откройте FLASHLIGHT.PRT в каталоге ISDX. 

 
Рисунок 31: Исходная Модель 

2. Щелкните по Insert > Style. 

3. Если необходимо, щелкните по View > Show All для возврата к однооконному виду. 

4. Щелкните по  [Установка активной опорной плоскости] в боковом меню и, затем, выберите 
опорную плоскость FRONT. 
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Рисунок 32: Установка Плоскости FRONT в Качестве Активной Опорной Плоскости 

Задача 2. Создать кривую и улучшить ее форму. 

1. Создайте плоскую кривую. Щелкните по  [Создание и редактирование кривых] > New > Planar, 
затем щелкните на активной плоскости в местах, как показано в следующем рисунке. 

 
Рисунок 33: Кривая 

2. Щелкните по  > FRONT. 

3. Щелкните по  > Edit >  [Отображение Диаграммы Кривизны] 

4. Щелкните по требуемым точкам кривой и растащите для получения формы кривой, приблизительно 
соответствующей показанной на следующем рисунке. Кривая должна быть расположена выше 
батарей. 

 
Рисунок 34: Редактирование и Настройка Кривой 

5. Щелкните по ОК для завершения создания кривой. 

Задача 3. Создать другую кривую на нижней стороне. 

1. Щелкните по  > New > Planar, затем щелкните в местах на плоскости FRONT, как показано на 
следующем рисунке. 
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Рисунок 35: Создание Нижней Кривой 

2. Улучшите форму кривой, используя те же методы, что и для предыдущей кривой, чтобы она 
приблизительно соответствовала предыдущему рисунку. 

3. Щелкните по ОК. 

Задача 4. Создать первую поперечную кривую и улучшить ее форму. 

1. Щелкните по  > DEFAULT. Затем щелкните по  [Стереть все точки кривизны] и выключите 

. 

2. Щелкните по  > New > Free. Нажмите и, удерживая <ALT>, щелкните по верхней кривой, затем 
щелкните по нижней кривой в местах, показанных на следующем рисунке. 

 
Рисунок 36: Задняя Часть Прожектора 

3. Щелкните по Add, затем щелкните в следующих двух местах для добавления точек, как показано на 
следующем рисунке. 

 
Рисунок 37: Добавленные Точки 

4. Щелкните по Edit. Удерживая <SHIFT>, щелкните и протащите точки приблизительно, как показано 
на следующем рисунке. 
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Рисунок 38: Создание Кривой, Путем Манипуляций Точками 

Задача 5. Сделать кривую, перпендикулярной плоскости FRONT. 

1. выберите верхнюю конечную точку новой кривой. Щелкните по Tangent,  измените ее тип на Normal 
и выберите плоскость FRONT. 

 
Рисунок 39: Создание Касательной к Плоскости FRONT 

2. Повторите вышеупомянутую процедуру для нижнего конца этой же кривой. 

Задача 6. Улучшить форму кривой. 

1. Щелкните по  > RIGHT. 

2. Щелкните по  и измените форму, управляя местоположениями точек и длинами касательных. 

 
Рисунок 40: Изменение Формы, Управляя Точками 

3. Щелкните по ОК. 

Задача 7. Создать другую поперечную кривую в виде плоской кривой. 

1. Щелкните по   > Default. Затем щелкните по  и выберите плоскость RIGHT. 

2. Щелкните по  > New > Planar. Затем щелкните по Planar для открытия выпадающего меню. 
Введите [-75.0] в текстовом поле Offset. 
3. Щелкните по Styling > Snap для включения привязки. 

4. Щелкните по верхней кривой, щелкните по следующим двум точкам, в местах, показанных на 
активной плоскости; затем щелкните по нижней кривой. 
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Рисунок 41: Создание Лицевой Части Прожектора 

5. Щелкните по Styling > Snap для выключения привязки. 

Задача 8. Наложить зависимости на касательные в конечных точках. 

1. Щелкните по Edit. Щелкните по конечной точке и  в меню Tangent, выберите Normal в меню 
быстрого вызова и выберите плоскость FRONT. 

2. Щелкните по > RIGHT. 

3. Измените форму кривой, как показано на следующем рисунке. 

 
Рисунок 42: Изменение Формы, Управляя Точками 

4. В диалоговом окне CURVE, щелкните по ОК. 

5. Регенерируйте модель, щелкая по  [Регенерировать все] при необходимости. 

Задача 9. Создать поверхность по кривым Стиля. 

1. Щелкните по  [Создание поверхности по граничным кривым] и выберите четыре созданных 
кривых Стиля, как показано на следующем рисунке. 

 
Рисунок 43: Выбор Граничных Кривых 

2. Щелкните по ОК. 
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3. Щелкните по  для закраски модели. 

 
Рисунок 44: Созданная Поверхность 

Задача 10. Переопределить местоположение смещенной плоскости. 

1. выберите плоскую поперечную кривую, как показано. 

 
Рисунок 45: Выбор Плоской Поперечной Кривой  

2. Щелкните по  > Definition. 

3. Щелкните по Planar для распахивания поля, введите [- 90], нажмите <ENTER> и щелкните по ОК. 

4. Щелкните по  для регенерации элемента Стиля. 

 
Рисунок 46: Регенерированный Элемент Стиля 

Задача 11. Создать кривые и поверхности ручки. 

1. Щелкните по  и выберите опорный элемент FRONT, затем щелкните по  > Front. 

2. Щелкните по  > New > Planar и создайте две кривые, как показано на следующем рисунке. 

 
Рисунок 47: Создание Двух Дополнительных Кривых 
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3. Щелкните по  > New > Free и создайте первую поперечную кривую, как показано на следующем 
рисунке. Используйте <Alt> для привязки к существующим кривым. 

 
Рисунок 48: Создание Свободной Кривой 

4. Щелкните по Add и выберите место для средней точки, как показано. 

 
Рисунок 49: Выбор Местоположения Средней Точки 

5. Щелкните по Edit и используйте <SHIFT>, для протаскивания точки перпендикулярно плоскости 
FRONT. Сформируйте кривую, как показано на следующем рисунке. 

 
Рисунок 50: Сформированная Кривая 

6. Используя те же методы, создайте новую кривую с формой, показанной на следующем рисунке. 
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Рисунок 51: Создание и Формирование Второй Кривой 

7. Щелкните по ОК для закрытия диалогового окна CURVE. 

8. Щелкните по , выберите четыре кривые, формирующие ручку и щелкните по ОК. 

9. Щелкните по  для закраски модели. 

 
Рисунок 52: Создание Поверхности по Четырем Кривым Стиля 

10. Щелкните по Insert > Surface Operation > Merge. 

11. выберите поверхность ручки, затем поверхность тела. 

12. Включите сетку для Quilt Sides, как показано на следующем рисунке. 

 
Рисунок 53: Стороны Лоскутной Поверхности 

13. Щелкните по . 

14. Щелкните по Feature > Mirror Geom и выберите плоскость FRONT. 
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Рисунок 54: Зеркально Отображенная Геометрия 

15. Щелкните по Insert > Surface Operation > Merge, выберите левую и правую половины тела 
прожектора и щелкните по . 

16. выберите кромку, показанную ниже и щелкните по  > Round Edges. 

 
Рисунок 55: Скругление Кромок 

17. Введите значение радиуса [5.0]. 

18. Повторите для другой стороны ручки. 

 
Рисунок 56: Скругленные Грани 

19. Щелкните по Insert > Thin Protrusion > Use Quilt и выберите лоскутную поверхность. 

20. Щелкните по стрелке Material Side, чтобы добавить материал INSIDE (Внутрь) поверхности. 

21. Введите значение толщины [2.0] и щелкните по . (Можно добавить кривые Стиля к слою и 
скрыть его) 
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Рисунок 57: Завершенная Модель 

22. Сохраните и закройте модель. 

Резюме 

В этом модуле, Вы узнали что: 

• ISDX интегрирует поверхности свободной формы и параметрические модели для усиления 
существующих возможностей Pro/ENGINEER в построении поверхностей, позволяя создавать 
такие формы изделий, которые требуют гибких поверхностей. 

• Стиль позволяет создавать геометрию, используя одно- или многооконную компоновку. 

• При создании элемента Стиль добавляется новое меню Styling и появляется множество новых 
команд. 

• Кривые могут быть созданы в виде трехмерных или плоских кривых. 

• Для создания художественной поверхности необходимо четыре соприкасающихся граничных 
кривых. 

• Для изменения формы поверхности следует манипулировать формой граничных кривых. 
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Глава 18 

Среда Разрешения Конфликтов 

Время от времени, при регенерации элементов моделей происходят конфликты. Для 
решения этих проблем можно использовать Среду Resolve (Разрешения). 
Изучив особенности Среды Разрешения Конфликтов будет возможным улучшать 
существующие элементы и параметры. Это намного удобнее и эффективнее, чем 
создавать их заново. 

Цели 
В этой главе Вы изучите: 

• описание различных типов ошибок регенерации. 

• Запуск Среды Разрешения Конфликтов. 

• Диагностику проблем регенерации элементов. 

• Запустите �quick fix (Быстрое решение)� для устранения причины конфликта регенерации. 

• Описание некоторых путей для изменения конструкции модели с целью разрешения 
конфликтов при регенерации элементов. 

Конфликты при Регенерации 

Конфликты обычно происходят, потому что изменение некоторого элемента находится в 
противоречии с требуемым изменением других элементов. Такие типы конфликтов происходят по 
следующим причинам: 

• создается новый элемент, который не присоединен или имеет односторонние кромки. 

• Восстанавливается элемент, конфликтующий с другим (например, наличие скругления и фаски 
на одной кромке). 

• Пересечение элемента более недействительно, потому что измененные размеры перенесли 
пересекаемые поверхности. 

• Вызываемая сборка не может открыть требуемые модели, которые входят в нее. 

• Сборочные зависимости для компонента - недействительны. 

• Уравнения зависимостей нарушены. 

Запуск Среды Разрешения Конфликтов 
В случае конфликта регенерации, Pro/ENGINEER автоматически запускает Среду Разрешения 
Конфликтов. В этом случае: 

• выпадающее меню File становится недоступным и модель нельзя сохранить. 

• Конфликтный элемент и все последующие элементы остаются не регенерированными. 
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• В текущей модели отображаются только те элементы, которые были регенерированы до 
момента конфликта. 

• Pro/ENGINEER отображает описание проблемы в Области Сообщений. 

• Pro/ENGINEER отображает в Менеджере Меню опции меню RESOLVE и окно диагностики. 

Разрешение Конфликтов Регенерации 
После входа в Среду Разрешения Конфликтов, можно обращаться с проблемой конфликта, используя 
любой из следующих методов: 

• отменить все изменения, сделанные с момента последней успешной регенерации. 

• Выполнить диагностику причины конфликта, используя текущую (конфликтную) или резервную 
модель. 

• Попытаться выполнить быстрое решение (quick fix) проблемы, используя команды быстрого 
вызова (shortcuts) для выполнения стандартных операций только над конфликтным 
элементом. 

• Изменить конфликтную или резервную модель используя стандартные функции детали или 
сборки. 

Определение Модели 
При диагностике или изменении модели, работы можно выполнять над текущей конфликтной 
моделью или резервной (backup) моделью. При использовании резервной модели, Pro/ENGINEER 
показывает все элементы в их состоянии до регенерации, чтобы можно было изменять или 
восстанавливать размеры элементов, которые не отображаются в текущей модели. 

При выборе опции Regen Backup из диалогового окна ENVIRONMENT, система сохраняет копию 
текущей модели на диск с названием REGEN_BACKUP_MODEL####.PRT перед каждой регенерацией, 
и удаляет файл при выходе из Среды Разрешения Конфликтов. Иначе, система использует 
последнюю версию текущей модели, сохраненную на диске до момента конфликта. 

Отмена Изменений 
В отличии от попытки разрешить проблему, можно просто отменить шаг, который заставил 
Pro/ENGINEER перейти в Среду Разрешения Конфликтов. Однако, этот вариант в некоторых случаях 
нельзя назвать оптимальным. Например, если элемент имеет конфликт по причине выполненных 
изменений, то даже при отмене изменений, собственно модель все еще останется проблематичной. 
Вариант с Undo - более подходит в тех случаях, в которых либо не планируется делать изменений, 
или требуется решить конфликт в модели без использования инструмента Разрешения Конфликтов. 

Обратите внимание: 
Следует помнить, что инструменты Среды Разрешения Конфликтов предназначены для решения 
конфликтов, с целью построения более гибких моделей. 

Диагностирование Проблемы 
При использовании Среды Разрешения Конфликтов рекомендуется изучить информацию по модели, 
чтобы определить причину конфликта. Система предоставляет различные средства диагностики для 
выполнения исследования. Для изучения модели можно использовать окно FAILURE DIAGNOSTICS, 
отображающее следующую информацию: 

• описание текущей и резервной модели 

• Информацию по конфликтному элементу 

• Подсказки по решению проблемы 
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Рисунок 1: Окно FAILURE DIAGNOSTICS 

Если требуется исследовать проблему далее, можно использовать опцию Investigate для получения 
следующей информации относительно текущей или резервной модели, если она существует: 

• измененные размеры. 

• Все модификации и изменения. 

• Все привязки конфликтного элемента в модели. 

• Недействительная геометрия конфликтного элемента. 

Затем можно откатить модель назад к одному следующего: к конфликтному элементу (только для 
резервной модели), к элементу, стоящему непосредственно перед конфликтным, к состоянию на 
момент последней успешной регенерации элемента или к указанному элементу. 

Выполнение Быстрого Решения Конфликтного Элемента 
Используя меню QUICK FIX, можно выполнять следующие действия только на конфликтном элементе: 

• переопределить его 

• Перенаправить его. 

• Подавить конфликтный элемент вместе с его потомками. 

• Удалить его вместе с его потомками. 

Обратите внимание: 
При выполнении изменения в Среде Разрешения Конфликтов, они могут воздействовать на 
конфликтный элемент или другой указанный элемент. Если элементы будут подавлены, используя 
меню QUICK FIX, необходимо исследовать причину конфликта перед продолжением построения 
детали. Если никаких исправлений не будет сделано, этот элемент нельзя будет возобновить в 
последующем. 

Изменение Модели 
Используя меню FIX MODEL, можно изменять любой элемент или компонент для решения проблемы 
регенерации. При изменении модели в Среде Разрешения Конфликтов следует, однако, изучить все 
отношения родитель / потомок, которые существуют между элементами и компонентами для 
предотвращения изменения назначения собственно модели. Конкретно, можно использовать любой 
из следующих подходов: 

• использовать меню FEAT для выполнения операций над элементами в модели. 

• Изменять размеры с использованием стандартного меню MODIFY. 

• Повторно регенерировать модель. 

• Восстанавливать размеры, параметры, уравнения или всех их до их состояния перед 
конфликтом. 

• Добавлять, удалять или изменять уравнения, по мере необходимости, для регенерации 
модели. 
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• Отображать меню PART SETUP для отображения дополнительных процедур настройки 
детали. 

Лабораторный Практикум 

Цель 
Цель этого практикума в разрешении конфликтов регенерации, с использованием среды 
разрешения конфликтов. 

Метод 
В этом упражнении, к детали будут добавлены элементы, которые послужат причиной конфликта 
других элементов. Затем, проблема будет исследована и решена в Среде Разрешения Конфликтов. 

УПРАЖНЕНИЕ 1: Разрешение Конфликта Регенерации 
Задача 1. Использовать опции Feature List и Model Player для определения того, как была построена 
фаска детали. 

1. Вызовите фаску детали. 

2. Откройте список элементов. Щелкните по Info > Feature List. Изучите Информационное Окно и 
закройте его. 

3. Регенерируйте модель по шагам. Щелкните по Utilities > Model Player. 

4. Выполните пошаговое перемещение по модели. Щелкните по  для регенерации элемент за 
элементом. 

Обратите внимание: 
Система регенерирует две фаски после двух выдавливаний. Опорные плоскости не будут видны, если 
они будут выключены. 

Задача 2. Вставить скругление на нижней кромке модели. Добавить скругления после второго 
(треугольного) выдавливания. 

1. Щелкните по Feature > Insert Mode > Activate в Менеджере меню. 

2. Встаньте после второго выдавливания. выберите второй элемент выдавливания модели. Обратите 
внимание, что система больше не отображает фаски, как показано на следующем рисунке. 

 
Рисунок 2: Среда Разрешения Модели 
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3. Щелкните по Insert > Round. 

4. Оставьте Simple по умолчанию. Затем щелкните по Done в меню ROUND TYPE. 

5. Оставьте опции Constant и Edge Chain по умолчанию и щелкните по Done в меню RND SET ATTR. 

6. Щелкните по Surf Chain в меню CHAIN. 

7. выберите скрытую нижнюю поверхность при помощи Query Sel и щелкните по Accept. 
8. выберите все подсвеченные кромки для скругления. Щелкните по Select All 
в меню CHAIN OPT; затем щелкните по Done в меню CHAIN. 

9. Введите значение радиуса. Введите [2.0] с последующим <ENTER>. 

10. Завершите элемент скругления. Щелкните по ОК. 

11. Щелкните по Feature List в выпадающем меню INFO. 

Обратите внимание: 
Система создала элемент скругления после второго выдавливания. Также, обратите внимание на 
статус регенерации двух фасок. 

12. Щелкните по Close для выхода из окна INFORMATION. 

13. Щелкните по Insert Mode > Cancel для выхода из режима вставки. Когда система запросит, 
требуется ли восстановить элементы, которые были подавлены при активизации режима вставки, 
введите [yes]. 
Задача 3. Pro/ENGINEER переходит в Среду Разрешения Конфликтов, потому что не может 
восстановить элемент фаски. Привязки для элемента фаски больше не существует. Система 
заменила их элементом скругления, созданным в режиме вставки. Выполните диагностику модели. 

1. Просмотрите всю информацию в окне FAILURE DIAGNOSTICS. 

2. Щелкните по Overview и просмотрите Resolve Feature Overview (Обзор Разрешения Элемента). 
Закройте окно. 

3. Щелкните по Feature Info и просмотрите Failed Feature Info (Информация по Конфликтному 
Элементу). Закройте окно. 

4. Щелкните по Resolve Hints и просмотрите предложения Pro/ENGINEER по решению проблемы. 
Закройте окно. 

5. Щелкните Investigate в меню RESOLVE FEAT. Примите по умолчанию Current Modl и щелкните по 
Show Ref в меню INVESTIGATE. 

6. Пройдите по окну отсутствующей фаски, щелкая по каждому объекту и просматривая привязки. По 
завершении просмотра отсутствующих привязок, щелкните по Close. 

Обратите внимание: 
На экране появляются привязки кромки для фаски, но они больше не являются частью модели. 
Созданный элемент скругления, удалил эти кромки. Поскольку он был регенерирован перед фаской, 
то его регенерация прошла успешно, а фаска потерпела неудачу. 

Задача 4. Разрешить конфликтный элемент, удаляя конфликтный элемент фаски из модели детали. 
Помните, что опция быстрого решения (quick fix) работает только с конфликтными элементами. 

1. Щелкните по Quick Fix в меню RESOLVE FEAT; затем щелкните по Delete в меню QUICK FIX. 
Прочитайте сообщение. Щелкните по Yes в меню YES/NO для выхода из Среды Разрешения 
Конфликтов. 

2. Снова просмотрите список элементов. Щелкните по Info > Feature List. Обратите внимание, что 
элемент фаски больше не является частью модели. Сохраните модель и сотрите ее из оперативной 
памяти. 
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Резюме 

В этом модуле, Вы узнали что: 

• конфликты при конструировании изделия не являются редкостью. 

• Pro/ENGINEER использует Среду Разрешения Конфликтов для исправления ошибочных 
элементов. 

• Конфликты обычно происходят при изменениях в конструкции различных деталей после 
создания сложных моделей. 

• Окно Failure Diagnostics (Диагностики Конфликтов) в Среде Разрешения Конфликтов 
отображает точную и детальную информацию, относящуюся к конкретному конфликту. 

• Перенаправление, переопределение, подавление и удаление элемента вместе с его 
потомками � некоторые из способов быстрого решения проблемы, которые могут быть 
выполнены на конфликтном элементе. 

• Конфликтная модель может быть исправлена более обстоятельно при помощи меню FIX 
MODEL. 
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Глава 19 

Информационные Инструменты 

В этой главе Вы изучите, как получать различную информацию по моделям и сборкам. Вы 
изучите, как выполнять запрос по конструкции для получения информации по регенерации, 
зазорам, характеристикам взаимопересечения и т.д. 

Цели 
В этой главе Вы изучите: 

• получение информации по элементам, деталям и сборкам. 

• Получение информации по регенерации. 

• Расчет масс-инерционных характеристик. 

• Расчет зазоров и взаимопересечений деталей. 

Информация по Модели 

Перед проведением каких либо модификаций или дополнений рекомендуется определить путь, по 
которому выполнялось построение модели. Pro/ENGINEER предоставляет полезные инструменты для 
извлечения информации по отдельным элементам, регенерации, сборочным зависимостям и всем 
моделям. 

Получение Информации по Конкретному Элементу 
Используя опцию Info Feature, можно получать информацию по конкретному элементу в режимах 
ДЕТАЛИ, СБОРКИ и РИСУНКА. 

Получение Информации по Регенерации 
Используя опцию Regen Info, можно последовательно выполнять регенерацию детали, начиная с 
указанного элемента, или с начала детали, в порядке их создания. 

Эта опция особенно полезна, потому что позволяет наблюдать конструкцию детали, и помогает 
определять некорректные методы проектирования. 

Вызов Информации по Элементам Детали 
Используя опцию Model, можно вызывать информацию по каждому элементу детали. Система 
перечисляет регенерированные и подавленные элементы, все системы координат, поперечные 
сечения и привязочные размеры в Информационном окне. 

Используя Feature List, можно перечислять все элементы модели в порядке их регенерации, получить 
номер элемента, ID элемента, название, тип, порядок подавления и состояние регенерации. 

Получение Информации по Сборкам 
Используя опцию Component в режиме Сборки, можно получить информацию по тому, как был 
собран компонент, как были сформированы его отношения родитель / потомок. 
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Также можно использовать опцию Model для вызова информации по выбранному компоненту сборки. 
В Информационном окне, система отображает названия компонентов в иерархическом виде для 
отображения того, как они были собраны. 

Совет: 
Система перечисляет в Информационном окне только названия объектов. Однако, если установить 
опцию файла конфигурации DISPLAY_FULL_OBJECT_PATH в yes, то будут отображаться полные 
имена объектов с путями и суффиксами типа объекта и номера версии. 

Измерения, Взаимопересечение и Масс-Инерционные 
Характеристики 

В выпадающем меню Pro/ENGINEER можно: 

• добавлять техническую информацию к проекту. 

• Анализировать модель посредством измерений. 

• Проверять на взаимопересечение. 

• Рассчитывать масс-инерционные характеристики. 

Расчет Масс-Инерционных Характеристик 
Используя опцию Model Analysis, можно вычислять масс-инерционные характеристики для детали, 
сборки и поперечных сечений. 

При вычислении масс-инерционных характеристик, система не включает массу подавленных 
элементов или подавленных компонентов на любой сборке. 
Обратите внимание: 
По умолчанию, масс-инерционные характеристики не обновляются автоматически при проведении 
изменений в модели. Необходимо повторно вычислить масс-инерционные характеристики. 

Используя опцию Model Analysis можно: 

• рассчитывать объем взаимопересечения между парами любых комбинаций подсборок, 
деталей, поверхностей, кабелей и примитивов. 

• Выполнять общую проверку зазоров в любых комбинациях деталей и подсборок с зазорами, 
меньше указанной величины. 

• Выполнять общую проверку на взаимопересечение между парами любых комбинаций деталей 
и подсборок. 

Лабораторный Практикум 

Цель 
В этом практикуме Вы научитесь извлекать информацию для определения того, как 
деталь была создана. 

Метод 
В Упражнении 1, Вы научитесь использовать информационные инструменты для вычисления 
размеров. 
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УПРАЖНЕНИЕ 1: Использование Информационных Инструментов 
Задача 1. Получить информацию по циклу регенерации шестерни. 
1. Откройте GEAR_COUNTERWEIGHT.PRT. 
2. Щелкните по Utilities > Model Player. 

3. Щелкайте по  до появления первого твердотельного элемента. 
4. Щелкните по Show Dims. 
5. Щелкните по Feat Info для получения информации по элементу, чтобы видеть, как он был создан. 
6. Щелкните по Close в ИНФОРМАЦИОННОМ ОКНЕ. 

7. Щелкните по  для продолжения поэлементной регенерации детали. 
8. Завершите регенерацию и закройте диалоговое окно MODEL PLAYER. 
9. Щелкните по Info > Model. 
10. Просмотрите список элементов в ИНФОРМАЦИОННОМ ОКНЕ, затем закройте его. 
Задача 2. Определить масс-инерционные характеристики модели. 
1. Щелкните по Analysis > Measure. 
2. Щелкните по Compute, принимая все опции по умолчанию в диалоговом окне MODEL ANALYSIS. 
3. Щелкните по Info в диалоговом окне MODEL ANALYSIS. Отображается информация относительно 
масс-инерционных характеристик. 
4. Прокрутите вниз ИНФОРМАЦИОННОЕ ОКНО и закройте его. 
5. Закройте диалоговое окно MASS PROPERTIES. 
Задача 3. Измерить модель. 
1. Щелкните по Analysis > Measure 
2. В диалоговом окне MEASURE, щелкните по Area в выпадающем списке TYPE. 
3. выберите переднюю цилиндрическую поверхность. 

 
Рисунок 1: Измерение Площади Поверхности и Длины Кривой 

Задача 4. Измерить длину кромки элемента шестерни. 

1. Щелкните по Curve Length в выпадающем списке TYPE. 

2. выберите кромку шестерни, как показано в предыдущем рисунке. 
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3. Длина кромки появляется в области сообщения на экране, а также в области RESULTS диалогового 
окна. 

Задача 5. Измерьте расстояние между двумя вершинами: 

1. Щелкните по Distance в выпадающем списке TYPE. 

2. Щелкните по Vertex в выпадающем списке FROM. 

3. выберите вершину, как показано на следующем рисунке. 

4. выберите Vertex в выпадающем списке TO. 

5. выберите вторую вершину, как показано. 

6. Система измеряет и отображает расстояние между вершинами в области сообщения и в области 
RESULTS диалогового окна. 

7. Щелкните по Close. 

 
Рисунок 2: Измерение Расстояния 

8. Сохраните модель и закройте окно модели. 

Резюме 

В этом модуле, Вы узнали что: 
• в Pro/ENGINEER можно получать информацию не только по построению модели, но также 

можно получать данные для анализа и обработки. 
• В любой модели можно получить информацию по любому конкретному элементу. 
• Можно вызывать информацию по любой конкретной детали, для изучения того, как она 

строилась, элемент за элементом, при помощи опции Regen Info. 
• Можно вычислять масс-инерционные характеристики для деталей, сборок и сечений, 

используя опцию Model Analysis. 
• В детали можно измерить, помимо всего прочего, расстояние между вершинами, длину кромки 

и площадь поверхности. 
• Можно вычислять взаимопересечение между парами любых комбинаций подсборок, деталей, 

поверхностей, кабелей и примитивов с целью снижения времени, потребного для определения 
глобального взаимопересечения между всеми компонентами. 
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Глава 20 

Конфигурирование Pro/ENGINEER 

В этой главе Вы изучите, как изменять рабочую среду Pro/ENGINEER. Вы научитесь 
конфигурировать Pro/ENGINEER для соответствия стандарту предприятия или вашим 
собственным потребностям. 

Цели 
В этой главе Вы изучите: 

• размещение конфигурационных файлов Pro/ENGINEER в сети. 

• Создание пользовательских рабочих сессий Pro/ENGINEER. 

• Автоматизацию процессов при помощи макрокоманд. 

Настройка Pro/ENGINEER 

Файлы конфигурации используются для настройки рабочей среды Pro/ENGINEER. Эти файлы могут 
включать ваши предустановки для допусков, форматы отображения, точности вычислений, 
количество цифр, используемых в эскизе и т.д. Имя файла конфигурации по умолчанию для 
Pro/ENGINEER - CONFIG.PRO. 

Файлы конфигурации можно редактировать для установки стандарта предприятия в нескольких 
областях, включая: 

• сохранение форматов рисунка. 

• Представление объектов проекта. 

• Установки единиц измерения по умолчанию для новых деталей (например, миллиметры 
вместо дюймов). 

• Установки расположения файлов библиотек. 

Определение Файлов Конфигурации 
Pro/ENGINEER может считывать файлы конфигурации из различных каталогов, как показано на 
следующем рисунке. Однако, если конкретная опция присутствует более, чем в одном файле 
конфигурации, то используется последнее считанное значение. 

При запуске, Pro/ENGINEER сначала считывает защищенный файл конфигурации, называемый 
CONFIG.SUP (".sup" расширение, установленное для �Supervisor (Супервизор)") в каталоге 
<LOADPOINT>/TEXT. Каталог установки Pro/ENGINEER. Эти опции имеют приоритет перед 
аналогичными опциями, которые могут быть установлены в других файлах конфигурации. 

Этот файл может использоваться для установки пользовательских стандартов предприятия для всех 
пользователей Pro/ENGINEER. Каждая запись в файле CONFIG.SUP блокирует любые двойственные 
записи в локальных файлах конфигурации CONFIG.PRO. 
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Рисунок 1: Возможные Местоположения Файлов Конфигурации в Сети 

Pro/ENGINEER считывает файлы конфигурации из следующих каталогов в нижеуказанном порядке: 

• Файл CONFIG.PRO в каталоге LOADPOINT. 

• Файл CONFIG.PRO в домашнем каталоге. 

• Файл CONFIG.PRO в каталоге запуска. 

• Значения по умолчанию, установленные в программном обеспечении. 

Обратите внимание: 
Полный перечень опций файла конфигурации и значений по умолчанию см. Введение в 
Pro/ENGINEER. Руководство Пользователя (Introduction to Pro/ENGINEER User�s Guide). 

Редактирование Файлов Конфигурации 
Файлы конфигурации можно редактировать в ходе рабочей сессии. Это выполняется в опции 
Preferences меню UTILITIES. 

На следующем рисунке показано диалоговое окно PREFERENCES. 

 
Рисунок 2: Диалоговое Окно PREFERENCES 

Обратите внимание: 
Файлы конфигурации не загружаются автоматически после редактирования. Их следует загружать 
щелкая по Utilities > Preferences. 
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Создание Макрокоманд 
Макрокоманды (Mapkeys) � клавиатурные макросы, которые можно создавать с использованием 
опции Mapkeys в выпадающем меню UTILITIES. При этом выполняется серия командных действий 
при нажатии только одной или двух клавиш. 

Диалоговое окно MAPKEYS перечисляет каждую макрокоманду, которая находится в сессии и 
содержит описание выполняемых ею функций. Диалоговое окно RECORD MAPKEY позволяет 
создавать, изменять, управлять, удалять и сохранять макрокоманды в файле конфигурации. Оба окна 
показаны на следующих рисунках. 

 
Рисунок 3: Диалоговые Окна Mapkeys и Record Mapkey 

Настройка Панели Пиктограмм 

Добавление Пиктограмм к Существующему Меню Пиктограмм 
Все опции выпадающих меню могут быть связаны с удобным при работе меню пиктограмм. Для этого, 
можно создавать новые пиктограммы и добавлять их к существующему меню пиктограмм. 

Диалоговое окно CUSTOMIZE включает список существующих опций выпадающих меню слева с 
соответствующими пиктограммами справа. Это показано на следующем рисунке. 

По мере прохождения, можно просто перетаскивать соответствующую пиктограмму на меню. 
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Рисунок 4: Настройка Пиктограмм Меню 

Сохранение Настроек 
Изменения в меню пиктограмм сохраняются с использованием опции Automatically Save To в 
диалоговом окне CUSTOMIZE. Эта опция создает файл, называемый CONFIG.WIN в том же самом 
каталоге, в котором находится файл. 

Этот файл автоматически загружается, при следующем запуске Pro/ENGINEER. 

Создание Выпадающих Меню 
Можно создавать отдельное выпадающее меню для новых созданных макрокоманд. Это позволяет 
использовать мышь для их выбора. Горячие клавиши, типа F1, также могут использоваться для 
макрокоманд. 

Совет: 
Присваивайте имена, чтобы можно было легко их запомнить. Например - sd для Cosmetic Shade. 

Присваивание Новых Пиктограмм для Макрокоманд 
Макрокоманды имеют связанные с ними пиктограммы по умолчанию, но имеется возможность их 
изменять. В диалоговом окне CUSTOMIZE, можно изменять отображение пиктограммы. Опции 
изменения включают возможность: 

• удалить пиктограмму. 

• Скопировать изображение пиктограммы. 

• Вставить скопированное изображение пиктограммы. 

• Отредактировать изображение пиктограммы в редакторе пиктограмм. 

• Выбрать изображение кнопки из предопределенного списка. 

• Отобразить текст, связанный с пиктограммой. 



  Pro/ENGINEER 2001 Базовый Курс 

- 263 - 

Дерево Модели 

Дерево модели - мощный инструмент для организации и управления активными объектами. 
Что очень важно, Дерево модели является информационным инструментом, аналогичным 
интерактивному инструменту управления, имеющим конфигурируемый интерфейс и инструмент 
поиска. 

 
Рисунок 5: Отображение Дерева модели 

Дополнительно к использованию Дерева модели для отображения элементов, его можно также 
конфигурировать для сохранения предопределенных и настроенных колонок, соответствующих 
объектам в дереве. 
Некоторыми, часто используемыми колонками являются: 

• Info � содержит следующую информацию 
− статус (регенерирован, не регенерирован, ошибочен, заморожен или подавлен). 
− Номер элемента. 
− ID элемента (как показано на Рис.5). 
− Тип элемента. 
− Имя элемента. 

• Layers � содержит статус слоя. 
• Model Params � отображает новые параметры модели, влияющие на всю модель. 
• Feat Params � отображает новые параметры, влияющие на элемент. 

 
Рисунок 6: Диалоговое Окно MODEL TREE COLUMNS  
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Диалоговое окно MODEL TREE COLUMNS доступно при выборе опции Model Tree Setup меню VIEW. 

Лабораторный Практикум 

Цель 
В этом практикуме Вы научитесь настраивать Pro/ENGINEER. 

Метод 
В Упражнении 1, Вы используете файл конфигурации и меню пиктограмм для настройки рабочей 
среды Pro/ENGINEER. 

В Упражнении 2, Вы создадите макрокоманду, повышающую эффективность работы. 

Инструменты 
ПИКТОГРАММА ОПИСАНИЕ 

   Сохранить как 

   Созданная пиктограмма макрокоманды 

УПРАЖНЕНИЕ 1: Настройка Файла Конфигурации 
Задача 1. Создать и отредактировать новый файл конфигурации в локальном каталоге. 

1. Откройте BUSHING.PRT. 

2. Щелкните по Utilities > Options. 

 
Рисунок 7: Редактирование Файла Конфигурации 

Задача 2. Изменить значения по умолчанию для настройки рабочей среды в соответствии со своими 
потребностями. 

1. В выпадающем меню SHOWING, выберите Current Session. 

2. Снимите переключатель Show only options loaded from file. 
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3. В выпадающем поле SORT выберите By Category. Затем, верните его в Alphabetical. 
4. Прокрутите список вниз и выберите spin_center_display. 

5. Значение по умолчанию - YES. Это означает, что центр вращения будет всегда отображаться при 
запуске Pro/ENGINEER. 

6. В выпадающем списке VALUE, выберите No, затем щелкните по Add/Change. 

 
Рисунок 8: Выбор Опций Файла Конфигурации. 

7. Включите поле Show only options loaded from file. В списке будут присутствовать только те опции, 
которые не являются значениями по умолчанию. 

8. В поле OPTION, введите [spin_with_part_entities], затем нажмите <ENTER>. 

9. В выпадающем списке VALUE, выберите YES и щелкните по Add/Change. Эта опция добавляется к 
списку измененных значений только в текущей сессии Pro/ENGINEER. 

 
Рисунок 9: Вторая Добавленная Опция 
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Задача 3. Добавить дополнительные опции, используя Keyword Search. Ищите опцию, которая 
запрашивает сохранять любые все не сохраненные данные при выходе из Pro/ENGINEER. 

1. В диалоговом окне OPTIONS, щелкните по Find. 

2. В поле TYPE KEYWORD, введите [exit]. 
3. Щелкните по Find Now. Одна опция найдена. Прочитайте описание и выберите ее. 

4. Установите значение по умолчанию в YES в диалоговом SET VALUE. Щелкните по Add/Change. 

Задача 4. Добавить опцию, которая увеличивает число строк в области сообщений Pro/ENGINEER. 

1. В поле TYPE KEYWORD, введите [message]. 

2. Щелкните по Find Now. 

3. выберите visible_message_lines. 

 
4. выберите visible_message_lines в диалоговом окне CHOOSE OPTIONS. Введите [5] в поле SET 
VALUE. 

5. Щелкните по Add/Change > Close. 

6. Щелкните по Apply в диалоговом окне OPTIONS. 

Задача 5. Сохранить изменения в установках таким образом, чтобы они действовали при каждом 
запуске Pro/ENGINEER. 

1. Щелкните по . 

2. Оставьте имя по умолчанию [config.pro]. 

3. Щелкните по ОК > Close. 

4. Щелкните по File > Exit для сохранения файла и выхода из редактора. 

Задача 6. Проверьте, что измененные установки действуют. Некоторые установки требуют 
перезапуска программы. 
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1. Щелкните по File > Exit. 
2. Запустите новую сессию Pro/ENGINEER и откройте BUSHING.PRT. 

3. Прокрутите деталь, используя мышь. Обратите внимание, что опорные плоскости при прокрутке 
продолжают отображаться. Это - результат изменения опции spin_with_part_entities. 

4. Измените элемент. Щелкните по Modify. выберите центральное отверстие втулки. выберите размер 
19.12, введите [10.00]. 

5. Щелкните по Regenerate для обновления геометрии. Обратите внимание, что область сообщений 
расширена и содержит пять строк. 

6. Щелкните по File > Exit > Yes. Так как измененная втулка не была сохранена, появляется запрос 
сохранить модель. 

7. Нажмите <ENTER>, чтобы сохраните деталь. 

8. Перезапустите Pro/ENGINEER. 

УПРАЖНЕНИЕ 2: Создание Макрокоманды 
Задача 1. Создайте макрокоманду переименования элемента. 

1. Откройте CRANK.PRT 
2. Щелкните по Utilities > Mapkeys. 
3. Щелкните по New в диалоговом окне MAPKEYS. 

Задача 2. Определить макрокоманду для работы. 

1. Введите [fn] в поле KEY SEQUENCE. 

2. Введите [Feature Name] в поле NAME. 

3. Введите [Name a feature for easy identification] в поле DESCRIPTION. 

4. выберите Pause for keyboard input. 
5. Щелкните по Record. 

Задача 3. Записать макрокоманду. 
1. Щелкните по Setup > Name. 

2. выберите элементы отверстия в модели. 

3. Введите [Shaft_bore] и нажмите <ENTER> 

4. Щелкните по Done. 

5. Щелкните по Stop в диалоговом окне RECORD MAPKEYS. 

6. Щелкните по ОК. 

7. Щелкните по Save, оставив имя по умолчанию CURRENT_SESSION.PRO. 

8. Закройте диалоговое окно RECORD MAPKEY 

Задача 4. Проверить действие макрокоманды. 

1. Введите [fn]. 

2. Щелкните по бобышке и введите новое имя [boss]. 

3. Щелкните по Info > Feature List. Обратите внимание на новые имена, присвоенные элементам 
модели. 

Задача 5. Включить пиктограмму в меню. 

1. Щелкните по Utilities > Customize Screen. 
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2. выберите третью пиктограмму справа; затем щелкните по Description. 

3. Прочтите описание, затем щелкните по <ENTER>. 

4. Перетащите пиктограмму за пиктограмму OPEN в меню SAVE, как показано ниже: 

 
Рисунок 10. Вставка Пиктограммы Стирания в Стандартное Меню Пиктограмм 

Задача 6. Настроить меню и включить в него пиктограмму созданной макрокоманды [fn]. 

1. В диалоговом окне CUSTOMIZE, выберите Mapkeys в CATEGORIES для ее подсветки. 

2. В области MAPKEYS диалогового окна, щелкните по лицу с улыбкой. 

3. Щелкните по Modify Selection > Choose Button Image. 

4. В диалоговом окне PICK MAPKEY ICON, щелкните по . 

5. Теперь перетащите ее из диалогового окна в меню. 
Обратите внимание: 
Система автоматически сохраняет изменения в файле CONFIG.WIN в рабочем каталоге. Рабочий 
каталог, в котором сохраняется файл, можно изменить. 

Задача 7. Завершить определение меню пиктограмм. 

1. Обратите внимание на элемент в нижней части диалогового окна. Оставьте опцию автоматического 
сохранения файла и щелкните по ОК. 

2. Часть пользовательского меню может быть похожа на следующее: 

 
Рисунок 11: Настроенное Меню Пиктограмм 

3. Сотрите текущую модель из памяти. Щелкните по новой пиктограмме Erase Current, затем 
выберите Yes. 

Резюме 

В этом модуле, Вы узнали что: 

• Среда Pro/ENGINEER может быть настроена. 

• Для конфигурирования среды следует вначале загрузить файл CONFIG.PRO. 

• Можно создавать макрокоманды для часто используемых последовательностей команд в 
процессе проектирования. 

• Для созданных макрокоманд можно создавать новые меню и пиктограммы. 

• Можно создавать новые выпадающие меню. 

• Дерево модели может использоваться в качестве информационного инструмента с 
дополнительными настраиваемыми колонками. 
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Глава 21 

Философия Моделирования 

Назначение конструкции - концепция, которая соединяет различные методы создания 
деталей, сборок и рисунков. В центре философии моделирования Pro/ENGINEER лежит 
возможность передачи назначения конструкции различными методами. 

Цели 
В этой главе Вы изучите: 

• возможности включения назначения конструкции в новые модели. 

• Преимущества использования отношений родитель/ребенок в конструкции. 

• Использование уравнений. 

• Важное значение ассоциативности в Pro/ENGINEER. 

• Описание изменения назначения конструкций в моделях. 

Назначение Конструкции 

Перед началом создания детали и сборки в Pro/ENGINEER, важно сначала определить назначение 
создаваемой конструкции. На этой предварительной стадии, назначение конструкции высшего уровня 
- обычно уже бывает известно. Перед началом нового проекта в Pro/ENGINEER, рекомендуется 
ответить на следующие вопросы: 

• каково назначение изделия? Как выполнить эти требования? 

• Какие основные узлы потребуются для удовлетворения этой функции? 

• Как эти отдельные узлы будут включены в общее изделие? 

• Какие изменения в конструкции могут произойти в процессе разработки? 

• Это новая продукция или изделие базируется на существующих разработках? 

• Какие существуют ограничения в конструкции? (размер, вес, стоимость и т.д.) 

• Как это изделие будет взаимодействовать на уровне своего окружения. 

Ответы на многие из этих вопросов могут уже существовать в виде технических требований к 
изделию, назначения изделия и предложений. Также, любой выполненный концептуальный дизайн, 
может обеспечить информацией, - как изделие будет выглядеть и как каждая из его подсистем 
взаимодействует друг с другом. 

Этой информацией можно управлять, используя Pro/INTRALINK и Pro/ENGINEER. Существующие 
документы, которые не являются файлами Pro/ENGINEER, могут управляться Pro/INTRALINK. Могут 
быть созданы зависимости между файлами не-Pro/ENGINEER и существующими сборками и 
деталями, с которыми они связаны. Таким образом, эта информация становится доступной 
конструктору, работающему на деталировке компонентов. 

Кроме того, результаты и идеи концептуального дизайна могут быть отображены в Pro/NOTEBOOK. 
Pro/NOTEBOOK (также известный, как Режим Компоновки) - необязательный модуль в Pro/ENGINEER, 
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который обеспечивает инструменты для создания двухмерных компоновок. Двухмерные эскизы и 
изображения конструкций сборки могут содержать критические размеры проекта, примечания и 
параметры. Эти параметры могут совместно использоваться среди всех компонентов сборки и могут 
использоваться для управления деталями конструкции, сборками и скелетами. 

Запись Критериев Проекта 
Перед созданием модели, необходимо записать критерии проекта для модели, которые могут 
включать: 

• порядок элементов. 

• Базовый элемент. 

• Копии элементов. 

• Форму элементов. 

• Тип элементов. 

• Глубину. 

Использование Pro/ENGINEER в Качестве Параметрического Инструмента 
• Одним из ключевых свойств параметрической природы Pro/ENGINEER является возможность 

генерировать отношения родитель/потомок. 

• Также можно использовать Pro/ENGINEER для установки взаимосвязей между размерами 
элемента путем создания уравнений без создания зависимостей родитель/потомок. 

Создание Отношений Родитель / Потомок 

Методы 
Ниже приведены некоторые из путей, при помощи которых можно создавать отношения родитель / 
потомок между элементами: 

• указание плоскости эскизирования / размещения. 

• Ориентирование плоскости привязки. 

• Образмеривание и указание привязок Эскиза и зависимостей. 

• Определение привязок глубина элемента / глубина. 

• Привязки кромок. 

• Зависимости компонентов сборки. 

Использование Уравнений 
Уравнения позволяют создавать зависимости между элементами или компонентами сборки без 
создания отношений родитель/потомок, в которых дочерние элементы управляют своими родителями. 
Обратите внимание: 
Назначение моделирования можно документировать, комментируя уравнения и изменяя символьные 
имена. 

Оптимизация Проектов с Уравнениями 
При разработке грамотных отношений родитель / потомок наряду с корректным параметрическим 
поведением модели, уравнения могут также оптимизировать некоторые критерии проекта. 

Оптимизация Проектов с Поведенческим Моделированием 
В Поведенческом Моделировании имеется возможность выполнять итеративный анализ проекта, 
развивая Исследование Проекта. На этом пути могут быть достигнуты различные цели. Можно: 

• определить зависимость между техническими условиями проекта и параметрами и/или 
размерами модели, используя Sensitivity Analysis (Анализ Чувствительности). 
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• Найти набор значений указанных параметров модели, который удовлетворяет набору 
конструктивных критериев при помощи Feasibility (Технической Осуществимости). 

• Найти набор значений указанных параметров, которые оптимизируют конструкцию на 
основании некоторых критериев. При этом должны быть удовлетворены технические 
требования проекта. Это достигается при помощи Optimization (Оптимизации). 

Преимущества Ассоциативности Pro/ENGINEER 

Создание Сборок 
Ассоциативность между рисунками, деталями, элементами дает легкую регенерацию и сокращает 
время, необходимое для проектирования сложных механизмов. 

Создание Скелетных Деталей 
Можно также создавать детали на уровне сборок, называемых skeletons (скелетами), для передачи 
назначения взаимосвязей между компонентами сборки. Эти детали можно также использовать для 
определения перемещений в сборке. 

 
Рисунок 1: Пример Скелета 

Использование Технической Записной Книжки 
Pro/ENGINEER позволяет организовать централизованное местоположение, документ, и управлять 
назначением конструкции модели изделия. Компоновки и параметрические отношения могут быть 
сохранены и восстановлены при необходимости. 

Изменение Назначения Конструкции 
• Redefine � изменяет любой исходный объект в элементе или созданную зависимость в сборке. 

• Reroute � изменяет внешние привязки, которые элемент или компонент имеют в модели. 

• Insert Mode � изменяет цикл регенерации, позволяя вставить элемент или компонент в цикл 
регенерации. 

• Reorder � изменяет порядок регенерации существующих элементов в детали или компонентов 
в сборке. 

• Interchange Mode � изменяет назначение конструкции в сборке путем замены одной 
функционально эквивалентной модели на другую. 
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Лабораторные Упражнения 

Цель 
Рассмотреть основные моменты назначения конструкции в качестве вопросов, которые 
обсуждаются  в дискуссии с преподавателем. 

Методы 
В Части 1, обсуждается Назначение Конструкции Уровня Детали. 

В Части 2, обсуждается Назначение Конструкции Уровня Сборки. 

Часть 1: Назначение Конструкции Уровня Детали 
В следующей модели детали цель состоит в том, чтобы построить модель максимально эффективно, 
насколько это возможно, сохраняя при этом назначение конструкции. Так как доступен единственный 
источника назначения конструкции � рисунок на следующей странице, его следует точно 
придерживаться. Вся модель должна быть построена, используя только показанные размеры: ни 
больше, ни меньше. Например, если конкретный элемент использует некоторый размер, никакой 
другой элемент не должен использовать этот же размер. 

 
Рисунок 2: Построение Модели с Определенным Назначением Проекта 

Анкета Процесса Решения 
1. Что должно являться базовым элементом? 

Ответ:  

  

  

2. Какие типы элементов допускаются для базового элемента? 

Ответ:  
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3. Какой из возможных типов элементов лучше всего передаст Назначение Конструкции? 

Ответ:  

  

  

4. Какой тип элемента (ов) может быть создан следующим? 

Ответ:  

  

  

5. Какой из возможных типов элементов лучше всего передаст Назначение Конструкции? 

Ответ:  

  

  

6. В каком порядке следует создавать элементы? 

Ответ:  

  

  

7. Как маленькое отверстие можно создать дважды? 

Ответ:  

  

  

8. Когда должны быть созданы скругления? 

Ответ:  
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Рисунок 3: Рисунок Модели Детали 

Часть 2: Назначение Конструкции Уровня Сборки 
Для следующего обсуждения, рассмотрите следующие виды и рисунок сборки КЛАПАНА. В целом, 
определите способы действия для создания сборки. Модели детали могут или, возможно, уже были 
созданы в Pro/ENGINEER. 
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Рисунок 4: Сборка Деталей 

Анкета Процесса Решения 
1. Какая методика может использоваться для связывания вместе компонентов сборки и анализа 
перемещений? 
Ответ:  
  
  
2. Какие типы элементов могли существовать в скелете? На что он похож? 
Ответ:  
  
  
3. Который компонент должен быть собран первым? Вторым? Как это воздействует при 
использовании скелета? 
Ответ:  
  
  
4. Что может произойти при удалении оси? Подавлении? Скрытии Слоя? Замене? Как некоторые из 
этих ситуаций могут быть обработаны? 
Ответ:  
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5. Как структура сборки должна быть на уровне узлов? 
Ответ:  
  
  
6. Требуется изменить угловую зависимость центра вала с 0° до 90°. Как это повлияет на наши 
решения? 
Ответ:  
  
  
7. Какие последствия будет иметь изменение центра диаметра оси на другие компоненты? 
Ответ:  
  
  
8. Как взаимодействия с другими компонентами будут влиять на процесс? 
Ответ:  
  
  

 
Рисунок 5: Сборочный Чертеж 
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Резюме 

В этом модуле, Вы узнали что: 

• Философия моделирования Pro/ENGINEER управляется требованиями эффективного 
воплощения назначения конструкции. 

• Элементно-ориентированная, параметрическая и ассоциативная природа Pro/ENGINEER 
имеет много преимуществ при передаче требуемого содержания. 

•  Возможность использования параметрических уравнений в процессе моделирования � 
специально разработанная особенность программы, которая служит целям передачи 
назначения конструкции. 

• Отношения Родитель/Потомок и методы их указания и изменения позволяют изменять 
содержание. 

• Информационные инструменты, рисунки, технические записи, поведенческий моделлер, 
возможность настройки среды Pro/ENGINEER, Среда Разрешения Конфликтов для устранения 
противоречий � все это служит достижению цели воплощения назначения конструкции и, 
таким образом, - являются необходимыми компонентами философии моделирования 
Pro/ENGINEER. 
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Приложение А 

Перечень Вопросов 

Эта глава содержит перечень вопросов, предназначенных для ежедневного совместного 
обсуждения в классе. Перечень разделен на пять частей, соответствующих пяти дням 
проводимого преподавателем обучения. 

Цели 
В этой главе Вы рассмотрите: 

• обзор важных концепций и принципов, которые обсуждаются в течении каждого дня обучения. 

• Обсуждение соответствующих тем. 

День 1: Перечень Вопросов 

1. Что является Назначением Проекта? 

 

 

 

 

2. Назовите три элемента, размещаемых по щелчку (pick and place features). 

 

 

 

 

3. Перечислите два типа эскизных элементов. 

 

 

 

 

4. Каковы преимущества твердотельного моделирования? 
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5. Перечислите три типа отверстий. Каковы опции размещения для каждого? 

 

 

 

 

6. Как эскизная плоскость передает назначение конструкции? Плоскость Привязки? 

 

 

 

 

7. Перечислите два способа создания скругления по цепочке кромок. 

 

 

 

 

8. Каково различие между отверстием и вырезом? 

 

 

 

 

9. Если при ориентировании эскизной плоскости с использованием горизонтальной привязки щелкнуть 
по ТОР в меню и выбрать Опорную плоскость ТОР, то которая сторона Опорной плоскости ТОР будет 
находится в верхней части экрана компьютера? 

 

 

 

 

10. Должна ли плоскость привязки всегда быть перпендикулярной к эскизной плоскости? 

 

 

 

 

11. Какие соглашения приняты в Pro/ENGINEER для ориентирования вида эскизной плоскости при 
создании элемента, который добавляет материал? Удаляет материал? 
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12. Что означает термин элементно-ориентированное моделирование? 

 

 

 

 

13. Что означает термин параметрический? 

 

 

 

 

14. Перечислите две функции, которые обеспечивают Привязки (References) в Среде эскизирования. 

 

 

 

 

15. Что наиболее важно при построениях в эскизе перед выходом из Среды эскиза? 

 

 

 

 

16. Каково различие между опциями ONE SIDE и BOTH SIDES при выдавливании или вырезе? 

 

 

 

 

17. Перечислите девять зависимостей эскиза. Которые из этих привязок являются многоцелевыми? 

 

 

 

 

18. Можно ли создать избыток или недостаток размеров сечения в Менеджере Намерений? 
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19. С каким элементом может использоваться Динамическое Изменение (Dynamic Modify)? Как его 
активизировать? 

 

 

 

 

20. Почему Менеджер Намерений создает "слабые" размеры? Как их можно удалить? 

 

 

 

 

21. Какова самая легкая процедура удаления или переопределения элементов? 

 

 

 

 

День 2: Перечень Вопросов 

1. Что такое шаблон модели? Что он содержит? 

 

 

 

 

2. Когда необходимо использовать шаблон при запуске? Может ли он быть настроен? 

 

 

 

 

3. Чем важен первый твердотельный «базовый» элемент? 
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4. Всегда ли эскизная и привязочная плоскость становятся родителями эскизных элементов? 

 

 

 

 

5. Что такое - отношения родитель / потомок в Pro/ENGINEER, и почему это столь важно? 

 

 

 

 

6. Устанавливают ли привязки Эскиза отношения родитель / потомок? Перечислите шесть вариантов 
установки привязок Эскиза. 

 

 

 

 

7. Почему требуется устанавливать параметры в Pro/ENGINEER? 

 

 

 

 

8. Что требуется в эскизе для создания элемента вращения? Что будет в случае, если их несколько? 

 

 

 

 

9. Какие два сечения требуются для элемента протягивания (swept feature)? 

 

 

 

 

10. Как создать трехмерный элемент протягивания (swept feature)? 
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11. Каково минимальное количество сечений, требуемых для элемента сопряжения (blended feature)? 
 

 

 

 

12. Какие требования для каждого сечения сопряжения? 

 

 

 

 
13. Возможно создать протянутый (swept) или сопряженный (blended) вырез? 

 

 

 

 

14. Для чего используются уравнения? Приведите пример. 

 

 

 

 

15. Как узнать, правильно ли работает уравнение? 

 

 

 

 

16. Каковы три типа сопряжений? Какие существуют две опции для каждого? 
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День 3: Перечень Вопросов 

1. Что такое - опорный элемент анализа (Datum Analysis feature) и как он используется? Перечислите 
три типа. 

 

 

 

 

2. Что означает BMX? 

 

3. Чувствительность и Оптимизация / Техническая осуществимость являются главными компонентами 
Поведенческого Моделирования. Дайте краткое определение каждому. 

 

 

 

 

4. Каково различие между Анализом и Элементом Анализа? Оптимизацией и Элементом 
Оптимизации? 

 

 

 

 

5. Что такое - шаблон рисунка? Перечислите не менее трех функций, которые могут быть установлены 
в шаблоне для выполнения. 

 

 

 

 

6. Как можно создавать многократные вхождения отдельного элемента? Отдельные вхождения 
нескольких элементов? 

 

 

 

7. Почему важно использовать опорные плоскости по умолчанию при ориентировании общего вида в 
рисунке? 
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8. Что является уникальным в основном виде (general View)? 

 

 

 

 

9. Каково различие между Проекционном и Вспомогательным видом? Выносным и Частичным видом? 

 

 

 

 

10. Как можно создавать повернутый размер в эскизном элементе, который затем будет размножен в 
массиве? 

 

 

 

 

11. Как включить размер и-или параметр в примечание рисунка? 

 

 

 

 

12. Как следует начинать каждую сборку? 

 

 

 

 

13. Каково важное назначение базового компонента в сборке? 

 

 

 

 

14. Действительно ли отношения родитель / потомок присутствуют в режиме Сборки? 

 

 

 

 



  Pro/ENGINEER 2001 Базовый Курс 

- 287 - 

15. По модели bracket.prt сделан рисунок. Затем в bracket.prt сделаны изменения. Будут ли виды 
рисунка повторно спроецированы? Что происходит со сборкой, использующей bracket.prt? Как 
называется эта особенность? 

 

 

 

 

16. Как можно изменять привязки размещения компонента без удаления компонента и повторной его 
сборки? Как можно это выполнить без взаимодействия с меню? 

 

 

 

 

17. Какую функцию выполняет <CTRL> <ALT> + третья кнопка мыши при сборке компонента? 

 

 

 

 

18. Перечислите пять типов зависимостей для сборки компонента. 

 

 

 

 

19. В чем состоит важность подсборок, и как их можно создавать в Pro/ENGINEER? 

 

 

 

 
20. Чем отличаются Mod Dim, Mod Assem, Mod Subasm и Mod Part? 

 

 

 

 

21. Перечислите различные опции копирования элементов. 
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22. Перечислите и сравните три типа Массивов. Сколько направлений доступно для каждого? 

 

 

 

 

День 4: Перечень Вопросов 

1. Для какой цели можно использовать слои в режиме Детали? Режиме Сборки? Режиме Рисунка? 

 

 

 

 

2. По каким трем причинам следует подавлять элементы Pro/ENGINEER? 

 

 

 

 

3. Не влияют ли слои на отношения родитель / потомок в процессе Подавления? 

 

 

 

 

4. Перечислите четыре типа дополнительных опорных элементов. 

 

 

 

 

5. Где еще используются опорные кривые? 

 

 

 

 

6. Опишите основные концепции Конструирования Сверху Вниз. 
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7. Что является шестью шагами или стадиями Конструирования Сверху Вниз? 

 

 

 

 

8. Что такое - скелет и как им можно пользоваться? 

 

 

 

 

9. Может ли скелет использоваться при проектировании детали, также как при проектировании 
сборки? Если да, то как? 

 

 

 

 

10. Что такое - поверхность? В какого типа моделях следует использовать поверхности? 

 

 

 

 

11. Что означает термин ISDX? 

 

 

 

 

12. Является ли ISDX единственным путем создания поверхностей в Pro/ENGINEER? 

 

 

 

 

13. Что может быть выполнено при помощи элемента STYLE? 

 

 

 

 

14. Сколько элементов (кривых, поверхностей) может содержаться в элементе STYLE? 
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15. Что требуется для создания поверхности с использованием ISDX? 

 

 

 

 

День 5: Перечень Вопросов 

1. Что такое - отношения родитель / потомок в Pro/ENGINEER? 

 

 

 

 

2. Перечислите семь способов установления отношений родитель / потомок в Pro/ENGINEER. 

 

 

 

 

3. Что является Назначением Проекта? 

 

 

 

 

4. Что означает термин ассоциативность? 

 

 

 

 

5. Что такое - файл конфигурации в Pro/ENGINEER, и почему его необходимо использовать? 
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6. Что такое � макрокоманда (mapkey)? 

 

 

 

 

7. Когда Pro/ENGINEER активизируют Среду Разрешения Конфликтов? 

 

 

 

 

8. Позволяет ли Pro/ENGINEER сохранять модель, которая имеет конфликтный элемент? 

 

 

 

 

9. Каково различие между опциями Quick Fix и Fix Model в меню RESOLVE? 

 

 

 

 

10. Почему следует попытаться исправить конфликтный элемент, а не использовать опцию Undo 
Changes в Среде Разрешения Конфликтов? 

 

 

 

 

11. Какая разница между опциями Redefine и Reorder? 

 

 

 

 

12. Что является преимуществами элементно-ориентированного моделирования? 
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13. Назовите четыре способа воплотить назначение конструкции в модели детали. 

 

 

 

 

14. Назовите три способа воплотить назначение конструкции в сборке. 

 

 

 

 

15. Какие опции доступны при выборе Analysis> Measure? При выборе Analysis > Model Analysis? 

 

 

 

 

16. Что такое проигрыватель модели (model player) и как он может использоваться? 

 

 

 

 

17. Каков Ваш следующий шаг в процессе изучения Pro/ENGINEER? 
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Приложение Б 

Проектная Работа 

Эта глава содержит углубленный проект, который можно выполнять после окончания 
стандартных упражнений. Цель этого проекта состоит в предоставлении Вам 
возможности приложить на практике навыки, полученные в классе; без пошаговых 
инструкций. 

Цели 
В этой главе Вы: 

• примените полученные навыки к реальным конструкторским проектам. 

Введение 

В течение следующих нескольких дней Вы будете проектировать несколько сборочных компонентов. 
Предполагается, что компоненты, созданные в этом курсе, будут являться деталями этой проектной 
работы. Однако, можно пропускать некоторые детали и использовать поставляемые модели для 
завершения узлов проекта. 

Как показано на следующем рисунке, будет создан корпус двигателя, нижний корпус, пружинное 
упорное кольцо и верхний корпус. Эти компоненты будут использоваться для построения сборок 
нагнетателя и двигателя. 

Все компоненты проекта будем сохранять в каталоге с названием project. Все единицы измерения - 
метрические. 

 
Рисунок 1: Трехмерное Представление Деталей Завершенного Проекта 



Pro/ENGINEER 2001 Базовый Курс    

- 294 - 

Создание Деталей 

Часть 1: Создание Двигателя 
Следуя Назначению Конструкции двигателя, его необходимо строить, используя только те размеры, 
которые показаны на следующем рисунке. Деталь создается с использованием выдавленных 
эскизных элементов и отверстий. Кроме того, следует использовать уравнения для создания 
зависимости постоянного расстояния от основания (прямоугольное выдавливание) под электронные 
платы до задней стенки базового элемента. 

 
Рисунок 2: Размеры Двигателя 

1. Создайте деталь с названием motor.prt. 

2. Создайте первый твердотельный элемент. Выдавите окружность с диаметром 70.00 на глубину 
90.00. 

3. Добавьте элемент основания под электронные платы. Это будет прямоугольник с размерами 82.5 X 
60.0, как показано на следующем рисунке (с высотой 60.00 от центра двигателя). 

 
Рисунок 3: Основание Под Электронные Платы 
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4. Следуя Назначению Конструкции, разместите основание на расстоянии 7.5 от цилиндрической 
поверхности базового элемента. Запишите уравнение, изменяющее размер основания под 
электронные платы (базовый элемент) при изменении глубины базового элемента. Выполните 
регенерацию детали и проверьте уравнение, изменяя глубину базового элемента. Не забудьте 
вернуть размер обратно к первоначальному значению глубины 90. 

5. Добавьте к модели передний элемент выдавливания с диаметром 100.0. Он будет использоваться в 
качестве фланца под болты. 

6. Добавьте элемент выреза к модели, чтобы можно было удалить материал для получения арматуры. 
Назначьте ему диаметр 60.00 и оставьте толщину стенки 5.0 в задней части двигателя, как показано в 
сечении А-А. 

Совет: 
Необходимо внимательно подходить к выбору или созданию опорных плоскостей для сечений, а 
также к типу создаваемого элемента. Толщина стенки 5.0 - ключевая при этом выборе. 

7. Добавьте элемент отверстия с диаметром 15.0 к задней части двигателя, которое будет 
использовано в качестве вала. 

8. Сохраните модель и очистите окно, стирая деталь. 

Часть 2: Создание Нижнего Корпуса 
В соответствии с назначением Конструкции нижнего корпуса, вырез вращения должен находиться на 
определенном расстоянии от боковых поверхностей базового элемента, чтобы модель сохраняла 
определенную толщину стенки. Кроме того, если диаметральные размеры базового основания 
изменяются, то элемент основания и элемент фланца также должны измениться. 

 
Рисунок 4: Нижний Корпус 

1. Создайте деталь с именем lower_housing.prt. 

2. Создайте первый твердотельный элемент. Создайте выдавливание полукруга диаметром 120 на 
глубину 80. 

3. Создайте в этой детали фланец для соединения с другим компонентом в сборке. Как показано на 
следующем рисунке, создайте элемент фланца, размером 15 x 4.1. (Подсказка: используя элементно-
ориентированную функциональность моделирования, создайте элемент с открытым сечением.) 
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Рисунок 5: Фланец Нижнего Корпуса 

4. Добавьте элемент основания к модели. Создайте эскиз элемента на центральной опорной 
плоскости и выдавите элемент в обоих направлениях, как показано на двух последующих рисунках. 

 
Рисунок 6: Базовое Основание Нижнего Корпуса 

 
Рисунок 7: Сечение Базового Основания Нижнего Корпуса 

Обратите внимание: 
В этом рисунке, эскизная осевая линия выровнена с силуэтной кромкой цилиндрической поверхности 
базового элемента. 

5. Добавьте к модели элемент поворотного выреза, как показано в следующем рисунке. Независимо 
от изменения глубины базового элемента толщина стенки должна оставаться 2.5. 
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Рисунок 8: Поворотный Вырез Нижнего Корпуса 

6. Вырежьте переднюю часть корпуса, как показано на следующем рисунке. 

 
Рисунок 9: Вырез Нижнего Корпуса 

7. Добавьте элемент отверстия диаметром 30 в задней части корпуса, в соответствии с размерами 
Нижнего Корпуса на рисунке в начале этой Части. По завершении, сохраните модель и сотрите деталь 
из памяти. 

Часть 3: Создание Пружинного Упорного Кольца 
Пружинное упорное кольцо покупается у поставщика и, поэтому, не нуждается в гибком подходе к 
проектированию. Его можно создать из двух элементов. 

 
Рисунок 10: Размеры Пружинного Упорного Кольца 
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1. Создайте деталь с именем snap_ring.prt. 

2. Создайте твердотельный элемент, выдавливая контур пружинного упорного кольца, как показано на 
следующем рисунке. Деталь имеет толщину 1.5мм. 

 
Рисунок 11: Сечение Пружинного Упорного Кольца 

3. Добавьте два простых радиуса закругления на боковых кромках окружности, как показано. По 
завершении, сохраните и сотрите модель. 

 
Рисунок 12: Скругления Пружинного Упорного Кольца 

Часть 4: Создание Верхнего Корпуса 
Согласно назначению конструкции верхнего корпуса, диаметр базового элемента связан со всеми 
другими элементами. Отвод размещается в модели симметрично сзади наперед. Для создания части 
геометрии, представляющей корпус, используется элемент протягивания, центрируемый 
относительно базового элемента. При выдавливании базового элемента по обе стороны эскизной 
плоскости, можно избежать создания дополнительной опорной плоскости позже. Для завершения 
геометрии выхлопа корпуса, следует создать элемент сопряжения, включающий расширяющуюся 
часть выхлопа корпуса. 
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Рисунок 13: Размеры Верхнего Корпуса 

1. Создайте деталь с именем upper_housing.prt. 

2. Выдавите полукруг диаметром 120 на глубину 80. Выдавите по обе стороны эскизной плоскости, 
чтобы можно было использовать ту же самую эскизную плоскость для траектории выхлопа корпуса. 

3. Используйте протягивание с атрибутом Free Ends для создания части выхлопа корпуса, как 
показано на первом из следующих рисунков. Выполните траекторию протягивания в виде линии и 
дуги, с расстоянием 81.5 от конца линии к центру корпуса и назначьте дуге радиус 100. Обеспечьте 
присоединение протягивания к базовому элементу в этом месте, вне зависимости от диаметра 
базового элемента, совмещая концевую точку дуги с цилиндрической и плоской поверхностями 
базового элемента (см. второй из следующих рисунков). Разместите начальную точку траектории в 
конце линии (обратите внимание на осевые линии в третьем рисунке). Создайте поперечное сечение 
в виде прямоугольника. 

 
Рисунок 14: Завершенный Элемент Протягивания 
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Рисунок 15: Сечение Траектории Протягивания 

 
Рисунок 16: Сечение Протягивания 

4. Создайте прямой параллельный элемент сопряжения для завершения выхлопа корпуса. 
Используйте только два сечения с глубиной 57.5 для Сечения 2. Создайте Сечение 1 сопряжения, 
используя кромку элемента протягивания. (подсказка: используйте осевую линию для обозначения 
симметрии в Среде эскизирования. 

 
Рисунок 17: Сечение Элемента Сопряжения 
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5. Ваша деталь должна быть похожа на следующий рисунок. 

 
Рисунок 18: Завершенный Элемент Сопряжения 

6. Создайте простое скругление по цепочке кромок с радиусом 15. Ваша деталь должна быть похожа 
на следующий рисунок. 

 
Рисунок 19: Скругления Верхнего Корпуса 

7. Для улучшения условий протекания потока воздуха, создайте простое скругление кромки с 
радиусом 40. 

8. Создайте следующее простое скругление кромки с радиусом 5. В качестве привязок выберите 
кромки, где элемент протягивания пересекает первый твердотельный элемент, как показано на 
предыдущем рисунке. 

 
Рисунок 20: Привязки Оболочки 

9. Создайте элемент оболочки. Удалите следующие две поверхности в качестве привязок: торцевую 
поверхность диффузора выхлопа (плоская поверхность элемента сопряжения) и нижнюю плоскую 
поверхность первого твердотельного элемента. Укажите значение 2.5 в качестве толщины оболочки. 



Pro/ENGINEER 2001 Базовый Курс    

- 302 - 

10. Добавьте фланец толщиной 04.1, как показано на следующем рисунке. Сделайте этот элемент 
подобным фланцу на двигателе. 

11. Сделайте вырез диаметром 97.5 спереди корпуса, как показано на следующем рисунке. 

 
Рисунок 21: Фланец Верхнего Корпуса и Вырез 

12. Сделайте отверстие диаметром 30 в задней части корпуса. Если в модели существует ось, 
создайте соосное отверстие. Если модель не имеет оси, создайте опорную ось. 

Обратите внимание: 

Для создания опорной оси выберите Insert, Datum, Axis, Thru Cylinder и выберите цилиндрическую 
поверхность базового элемента выдавливания. Опорные оси будут подробно пояснены позже. 

 
Рисунок 22: Верхний Корпус 

13. Добавьте гладкое отверстие, как показано в виде Detail A размеров Верхнего Корпуса в начале 
этой Части. После завершения, сохраните модель и сотрите ее из оперативной памяти. 
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Создание Сборок 

Для завершения деталей для этих сборок, Вы измените детали, создадите новые элементы и 
добавите уравнения в режимах Сборки и Детали. Хотя модели не завершены, Вы начнете создавать 
рабочие рисунки и сборки. По завершении этого проекта, можно будет проследить ассоциативность 
между файлами детали, сборки и рисунка. 

Обратите внимание: 
Необходимо пытаться использовать модели, которые были выполнены в предыдущей работе. При 
создании этих сборок и рабочих рисунков, можно использовать модели, созданные ранее или модели, 
которые сохранены в библиотеке и которые отражают модель в конце предыдущего проекта. 
Сохраненный модели обозначены круглыми скобками (). 

Часть 1: Создание Сборки Двигателя 
Сохраняя назначение конструкции, необходимо наложить все зависимости на все модели детали в 
сборке. Двигатель должен быть размещен в качестве первого компонента. На этом этапе проекта, 
изменяется только двигатель в режиме Детали. 

 
Рисунок 23: Трехмерное Представление деталей Завершенной Сборки Двигателя 

1. Создайте сборку с именем motor.asm. 

2. Соберите двигатель, созданный в предыдущей работе (или beta_motor.prt) по опорным плоскостям 
сборки по умолчанию. После размещения его в сборке, выключите отображение опорных плоскостей, 
для облегчения размещения остальных компонентов. 

3. Соберите вал двигателя (beta_shaft.prt) в сборку. (См. следующие два рисунка). 

 
Рисунок 24: Вал, Собранный с Двигателем 
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Рисунок 25: Привязки Выравнивания для Вала Двигателя 

4. Создайте канавку в вале для пружинного упорного кольца, чтобы он не скользил в двигателе. 
Выполните регенерацию вала двигателя (beta_shaft.prt) в отдельном окне. 

5. Скопируйте первую канавку и создайте вторую на расстоянии 141.8, как показано на следующем 
рисунке. 

 
Рисунок 26: Копирование Канавки 

6. Сохраните и закройте модель вала. 

7. Откройте сборку двигателя. Обратите внимание, что на валу появилась канавка под пружинное 
упорное кольцо. 

8. Соберите snap_ring.prt (beta_ring.prt) в канавку (вырез вращения) вала двигателя. 

9. Соберите крышку двигателя (beta_cover.prt) с двигателем. Создайте только привязки 
родитель/потомок между двигателем и крышкой. 

10. Создайте массив сборки для установки второго пружинного упорного кольца, используя �ref 
pattern�. 

11. Включите отображение опорных плоскостей. 
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Рисунок 27: Сборка Двигателя 

12. Обратите внимание, что размноженная канавка под пружинное упорное кольцо размещено 
слишком далеко вниз на валу. Измените смещение скопированной канавки на валу двигателя 
(beta_shaft.prt) на 127.5 и выполните регенерацию. 

13. Сохраните сборку. 

Часть 2: Параллельное Проектирование Корпуса Двигателя 
На этом этапе процесс проектирования корпуса двигателя и большинства других компонентов сборки 
еще не завершен. Можно одновременно работать между сборками и деталями в Pro/ENGINEER. Для 
подготовки к созданию в двигателе установочных отверстий, создайте набор отверстий в двигателе, 
соответствующих тем, которые будут созданы в крышке. 

1. Откройте двигатель (beta_motor.prt). Добавьте отверстие под углом, используя радиальное 
размещение. Используйте радиальный размер. 

2. Создайте радиальный массив, используя три вхождения. По завершении, сохраните модель и 
закройте окно. 

 
Рисунок 28: Радиальный Массив Отверстий в Двигателе 

Часть 3: Создание Сборки Нагнетателя 
Согласно назначению конструкции этой сборки, нижний корпус используется в качестве основного 
компонента и все собирается на нем. По мере сборки компонентов, обнаружится, что несколько 
элементов отсутствует. Создайте эти элементы, используя опцию Modify в режиме Сборки. 

1. Создайте сборку с именем blower.asm. 

2. Соберите lower_housing.prt (beta_lower.prt) по трем опорным плоскостям сборки по умолчанию. 

3. Нижний корпус был создан без каких либо отверстий во фланце. Изменяя деталь на уровне сборки, 
создайте отверстие в нижнем корпусе и размножьте его массивом в режиме Сборки. Создайте гладкое 
отверстие на фланце со схемой образмеривания, показанной на следующем рисунке. 
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Обратите внимание: 
Не выходите из меню FEATURE после создания отверстия. В следующей задаче будет использована 
команда Pattern из того же меню. 

 
Рисунок 29: Размеры Отверстия 

4. Скопируйте отверстие для создания четырех (4) вхождений, включая исходное. Если Вы вышли из 
меню FEATURE, выберите Modify, Mod Part,. выберите нижний корпус; затем выберите Feature. 
Обратите внимание: 
Не выходите из меню FEATURE после создания массива. В следующей задаче будет использована 
команда Copy из того же меню. 

5. Согласно назначению конструкции, необходимо зеркально отобразить фланец с массивом 
отверстий на другую сторону модели (как показано на следующем рисунке). 

 
Рисунок 30: Привязки Зеркального Отображения 

6. Соберите нагнетатель, детали которого были выполнены в уроке "Копирование Элементов: 
Операции Массива и Копирования". (Если модель не закончена, используйте деталь с именем 
beta_blower в текущем каталоге). Используйте команду сопряжения со смещением 1 для размещения 
ее относительно задней стенки нижнего корпуса. Выйдите из меню модификации детали. 

7. Обратите внимание на видимое взаимопроникновение между нижним корпусом и нагнетателем при 
тонировании модели. Измените размер лопасти нагнетателя с 73.5 на 65.0 и регенерируйте деталь. 

8. Соберите верхний корпус (beta_upper.prt) с нижним корпусом. Полностью привяжите компонент 
сопряжением фланцевой поверхности, совмещая центральную ось и совмещая переднюю 
поверхность обоих компонентов. 
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9. Верхний корпус не имеет массива установочных отверстий на фланце. Откройте деталь, чтобы 
можно было проводить изменения в режиме Детали в ее собственном окне. 

10. Создайте четыре отверстия, размножая их с приращением 20. 

11. Используйте Copy, Mirror для создания фланца и отверстий на другой стороне базового 
элемента. 

 
Рисунок 31: Команда Копирования Верхнего Корпуса 

12. Сохраните файл детали и закройте окно. Активизируйте окно сборки. Обратите внимание, что 
сборка теперь содержит изменения, сделанные в режиме Детали. Сохраните сборку и сотрите окно. 

Часть 4: Создание Рисунка Двигателя 
Хотя двигатель полностью не завершен, начнем создание рабочих рисунков. В рисунке, виды и 
размеры обновляются вместе с изменениями в модели детали независимо от того, сделаны ли 
изменения в режиме Детали, Сборки или Рисунка. На этом этапе проекта, Вы настроите только виды 
рисунка; аннотирование выполните позже. 

1. Создайте рисунок с именем motor.drw. 

2. Используйте лист размера C и свяжите его с motor.prt (beta_motor.prt). 

 
Рисунок 32: Размещение Видов Рисунка Двигателя 

3. Добавьте первый основной (general) вид. Сориентируйте его как вид сбоку модели двигателя, 
используя опорные плоскости по умолчанию. Используйте No Scale, чтобы Pro/ENGINEER определил 
масштаб рисунка. 
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4. Добавить проекционный вид спереди, названный вторым видом в предыдущем рисунке. 

5. Добавьте проекционный вид сзади, названный третьим видом в предыдущем рисунке. 

6. Добавьте проекционный вид сверху, названный четвертым видом в предыдущем рисунке. 

7. Добавьте поперечное сечение, названное пятым видом в предыдущем рисунке. 

8. Добавьте шестой вид как основной с масштабом 0.75. 

9. Измените способ отображения видов. Для первого, третьего и пятого видов, измените способ 
отображения на Hidden line, Tan Phantom. 
10. Измените способ отображения оставшихся видов на No Hidden, No Disp Tan. 
Обратите внимание: 

Как только вид будет установлен с использованием Display Mode, он остается в этом состоянии, даже 
если установка Среды будет изменена. 

11. Сохраните рисунок. 

12. Создайте рисунок с именем motor_asm.drw. 

13. Используйте лист размера С и свяжите его с моделью MOTOR.ASM, используя диалоговое окно. 

 
Рисунок 33: Размещение Видов Сборочного Рисунка Двигателя 

14. Разместите первый основной вид. выберите No Scale. 

15. Разместите второй проекционный вид. 

16. Разместите третий проекционный вид. 

17. Разместите четвертый проекционный вид. 

18. Измените способ отображения всех видов на No Hidden, No Disp Tan. По завершении, сохраните 
модель и сотрите все. 
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Исследование Моделей 

Продолжим разработку модели согласно назначению исходной конструкции. Сделаем это путем 
добавления элементов, анализа масс-инерционных свойств для отдельных деталей и целых сборок и, 
исследуя взаимопересечение между компонентами. Также напишем уравнения для предотвращения 
взаимопересечения между компонентами. После завершения этих задач, разместим узел нагнетателя 
в сборке двигателя. 

Деталь крышки не завершена. Согласно назначению конструкции, необходимо создать ушки для 
монтирования крышки на двигатель и добавить охлаждающие пазы в верхней части, как показано на 
следующем рисунке. 

 
Рисунок 34: Изменение Крышки 

Часть 1: Проектирование Крышки 
1. Откройте крышку. 

 
Рисунок 35: Крышка 

2. Для облегчения создания паза для охлаждения, подавите выдавливание, отверстие и скругление в 
верхней части базового элемента. 

3. Добавьте первый паз, как показано на Виде C измененной крышки. 

4. Размножьте паз семь (7) раз, включая оригинал. 

5. Восстановите подавленные элементы. 
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6. Обратите внимание на следующем рисунке, что система удалила нижнюю часть маленькой 
цилиндрической бобышки при добавлении охлаждающих лопастей. Эскиз второго выдавливания 
первоначально был нарисован внутри базового элемента. Переупорядочьте вырез и размножьте его 
после первого выдавливания. Обратите внимание на разницу в модели. 

 
Рисунок 36: X-сечение Крышки Перед Упорядочиванием 

 
Рисунок 37: X-сечение Крышки После Переупорядочивания 

7. Добавьте выдавливание, которое можно размножить с поворотом. В качестве горизонтальной или 
вертикальной плоскости привязки, используйте внутренний опорный элемент под углом. Позже, можно 
использовать ассоциированный угол для создания массива. Сделайте эскиз незамкнутого сечения, 
показанный на следующем рисунке. Выдавите его на глубину 5.0. 

 
Рисунок 38: Эскиз Разомкнутого Сечения 
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Рисунок 39: Круговой Массив 

8. Размножьте ушко, с приращением угла 120°. Создайте три вхождения, включая оригинал. 

9. Создайте опорную ось через цилиндрическую поверхность ушка. 

10. Привяжите массив к опорной оси. 

11. Создайте соосное гладкое отверстие на ушке. Задайте диаметр 7.5. 

 
Рисунок 40: Крышка Перед Привязкой Массива Отверстий 

12. Привяжите массив гладких отверстий. По завершении, сохраните модель. 
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Часть 2: Завершение Двигателя 
На данный момент определена окончательная конструкция основания двигателя. На этом этапе 
проекта будет создано основание на цилиндрическом базовом элементе. 

 
Рисунок 41: Изменения в Двигателе 

1. Откройте двигатель (gamma_motor.prt). 

2. Подавите все элементы, за исключением первого твердотельного выдавливания и опорных 
плоскостей по умолчанию. 

3. Добавьте элемент основания двигателя, как показано на следующем рисунке (Подсказка: 
используйте сечение, которое не закрывает центральное отверстие, когда оно будет восстановлено. 
Незамкнутое сечение также будет работать). 

 
Рисунок 42: Основание Двигателя 

4. Восстановите все подавленные элементы. 

5. Создайте вырез на стороне основания под электронные платы, как показано в Виде А изменений, 
сделанных в двигателе. Размножьте вырез для включения четырех (4) вхождений, включая оригинал. 
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Рисунок 43: Вырез Сбоку 

6. Зеркально отобразите размноженные элементы выреза, которые находятся на стороне основания 
под электронные платы на другую сторону. После завершения сохраните модель и сотрите все. 

Часть: 3: Завершение Сборки Нагнетателя 
Для завершения сборки, измерьте взаимопересечение и создайте уравнения сборки, чтобы 
предотвратить деталь нагнетателя от соударения с другими компонентами. Кроме того, будет создана 
Спецификация (BOM) и вычислены масс-инерционные характеристики компонентов сборки. 
1. Откройте blower.asm (gamma_blower.asm). 
2. Измените высоту лопатки нагнетателя (gamma_blower.prt)  с глубины 65 на 73.5. Выполните 
регенерацию сборки. 
3. Измерьте взаимопересечение между компонентами сборки нагнетателя. Используйте опцию Model 
Analysis� в выпадающем меню Analysis. выберите Global Interference в  выпадающем списке Type 
в диалоговом окне. выберите опции по умолчанию, показанные на следующем рисунке. Переключайте 
результаты моделей, щелкая на стрелках в диалоговом окне. 

 
Рисунок 44: Диалоговое Окно Модального Анализа 
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4. Разнесите модель сборки так, чтобы можно было видеть ее внутреннюю часть. Щелкните по Modify, 
Mod Explode для изменения положения нагнетателя, используя перпендикулярную плоскость, как 
показано на следующем рисунке. 

 
Рисунок 45: Покомпонентный Вид Сборки 

5. Определите расстояние, которое может использоваться для нагнетателя. Измерьте расстояние от 
задней внутренней поверхности нагнетателя до передней внутренней поверхности нагнетателя, 
используя Analysis, Measure, Distance и выберите поверхности, показанные на предыдущем рисунке. 
Запомните значение расстояния. 

6. Снова измените высоту лопатки нагнетателя, чтобы она была в пределах нижнего корпуса. 
Измените длину лопатки, для соответствия измеренному расстоянию за минусом толщины верхней и 
нижней части нагнетателя и зазора. С текущими значениями расстояние равно 75 - (5 + 2.5 + 5) или 
62.5. 

7. Создайте уравнение, которое заставит нагнетатель всегда центрироваться по нижнему корпусу, 
введя величину отступа. Используйте параметры, показанные на следующем рисунке. 

 
Рисунок 46: Символьные Размеры для Уравнений Сборки 

8. Обратите внимание, что нижний корпус не имеет никаких размеров, которые контролируют 
внутренние размеры полости. Согласно назначению конструкции, необходимо управлять толщиной 
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стенки. Это назначение будет передано управлением размера 2.5 выреза вращения (отображенного, 
как d8:0, d10:0, и d9:0 в предыдущем рисунке) всех кромок поверхности модели. 
9. Создайте несколько параметров в нижнем корпусе. Откройте нижний корпус (или gamma_lower.prt) в 
подокне. выберите Relations, выберите вырез вращения и базовое выдавливание для отображения 
их символьных размеров. 
10. Запишите уравнение, которое равно длине выреза (cut_length = D1 - (d8 + d10)). Помните, что 
используете символьные размеры. Введите название параметра в уравнении, чтобы автоматически 
создать параметры в модели. 
11. Сохраните lower_housing.prt (или gamma_lower.prt) и закройте окно. Снова активизируйте окно 
сборки. 
12. Создайте другой параметр в модели нагнетателя, который представляет общую высоту 
нагнетателя, включая основание, лопасть и верхнюю часть. Откройте нагнетатель (или 
gamma_blower.prt) в другом окне. Добавьте следующее отношение, height = d1+d9+d18, для 
автоматического создания параметра высоты. 
13. Сохраните нагнетатель и закройте окно. 
14. Установите смещение модели нагнетателя в пределах нижнего корпуса, чтобы он был равномерно 
смещен. Введите в отношение, подобное d0:1 = (cut_length:0 - height:2) / 2. 
15. Регенерируйте модель. Проверьте область сообщения на наличие предупреждения системы. 
Возможно, придется дважды выполнять регенерацию, в зависимости от порядка, в котором были 
добавлены отношения. (Подсказка: используйте Sort Rels). 
16. Щелкните по Analysis > Model Analysis, чтобы вычислить масс-инерционные характеристики 
сборки. Добавьте выбранные значения плотности к компонентам. (Например, 7.63e-9 тонн/мм3 для 
стали) 
17. Используйте меню Info для создания BOM. По завершении, сохраните модель. 

Часть 4: Завершение Сборки Двигателя 
На этом этапе проекта, Вы завершите сборку двигателя, привязывая сборку нагнетателя к сборке 
двигателя. Также будет исследовано различие между скрытием слоя в сборке и подавлением 
компонентов, используя инструмент Дерева модели. При подавлении компонентов, система 
переходит в Среду Разрешения Конфликтов, потому что привязки компонентов отсутствуют. 
1. Откройте motor.asm (gamma_motor.asm). 
2. Переопределите зависимости крышки, чтобы крепежные отверстия совместились с отверстиям 
двигателя. Добавьте зависимость выравнивания. Выберите ось первого отверстия ушка крышки и 
соответствующую ось на двигателе. 
3. Соберите blower.asm (gamma_blower.asm) с motor.asm (или gamma_motor.asm). Используйте 
зависимости на собственное усмотрение. 
4. Измените отображение колонки Дерева модели, чтобы показать Status и FeatID. Перечислите 
подавленные компоненты, выбирая View, Model Tree Setup и Item Display. 

 
Рисунок 47: Дерево Модели Сборки Двигателя 
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5. Создайте слой в сборке верхнего уровня с именем "base_comp". 

6. Установите все компоненты (не посборки) двигателя на слой BASE_COMP. 

7. Скройте слой BASE_COMP, как показано на следующем рисунке. 

 
Рисунок 48: Диалоговое Окно Установки Отображения 

Обратите внимание: 
Обратите внимание, что детали двигателя больше не видны в рабочем окне, но все еще находятся в 
списке Дерева модели с состоянием Regenerated. 

8. Скройте слой BASE_COMP. 

9. Подавите компонент двигателя. 

Обратите внимание: 
Pro/ENGINEER запрашивает выбрать опцию для дочерних компонентов. Однако, их нельзя 
перенаправить или переопределить, потому что все они привязаны к базовому компоненту сборки. 

10. Временно исключите (suspend) все дочерние компоненты. 

Обратите внимание: 
Временное исключение (suspend) - временное действие; которое только приостанавливает действие 
компонента до следующей регенерации, которая в нашем случае произойдет после выбора 
Done/Return. Это действие приведет к ошибке в Сборке. 

11. Система переходит в Среду Разрешения Конфликтов потому, что дочерние компоненты имеют 
отсутствующие привязки. Для выхода из Среды Разрешения Конфликтов, выберите Quick Fix и 
Freeze для всех компонентов. Как только система заморозит один компонент, другой компонент будет 
причиной вызова Среды Разрешения Конфликтов, потому что он также имеет отсутствующие 
привязки. 

12. После выхода из Среды Разрешения Конфликтов, просмотрите подавленные, замороженные и 
регенерированные компоненты, перечисленные в колонке Status Дерева модели. 

13. Восстановите двигатель. Обратите внимание, что все замороженные компоненты в Дереве модели 
автоматически обновляются. Сохраните модель и сотрите все компоненты. 
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Завершение Проекта 

Теперь Вы готовы завершить проект, завершая детали, сборки и рисунки. После аннотирования 
деталей и сборки двигателя в рабочих рисунках, просмотрите ассоциативность между всеми тремя 
режимами Pro/ENGINEER. 

 
Рисунок 49: Изменения в Двигателе 

Часть 1: Продолжение Детали Двигателя 
Согласно назначению конструкции, требуется увеличить ширину переднего фланца двигателя и 
изменить отверстия во фланце. Выполните эти изменения в режиме Детали. 

1. Откройте motor.prt (delta_motor.prt). 

2. Измените толщину переднего фланца на 15. 

3. Удалите три отверстия с переднего фланца. 

4. Создайте три эскизных отверстия, используя радиальное размещение. Эскиз сечения показан на 
следующем рисунке. 

 
Рисунок 50: Эскиз Сечения Отверстия 



Pro/ENGINEER 2001 Базовый Курс    

- 318 - 

 
Рисунок 51: Завершенные Отверстия 

5. Сохраните модель и закройте окно. 

Часть 2: Окончание Нижнего Корпуса 
Согласно назначению конструкции, требуется усилить цилиндрическую стенку базового элемента, 
создавая несколько ребер с присоединенным элементами уклонов. 

1. Откройте lower_housing.prt (delta_lower.prt). Постройте ребро между цилиндрическим базовым 
элементом и основанием. Размеры см. на следующем рисунке. Используйте Make Datum для 
создания смещенного опорного элемента в качестве эскизной плоскости. Обратите внимание на 
направление смещения. 

 
Рисунок 52: Размеры Ребра 

2. Создайте элементы уклона на двух параллельных сторонах ребра. Примите атрибуты по 
умолчанию Neutral Plane, No Split и Constant. Создайте нейтральную плоскость через верхнюю 
кромку ребра, параллельно базовым поверхностям. Используйте нейтральную плоскость в качестве 
плоскости привязки. Введите угол уклона [-10]. 
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Рисунок 53: Привязки для Элемента Уклона (поверхности для ясности сделаны с сеткой) 

3. Скопируйте элементы ребра и уклона для создания двух подпорок. Используйте Move и выберите 
атрибут Dependent. Перенесите элементы с привязкой к передней части модели на расстояние 3.00 

4. Выполните зеркальное отображение элементов ребра и уклона на другую сторону детали. Если эта 
операция приводит к конфликту из-за невозможности построить геометрию, переопределите угол 
уклона на �10°. После завершения этой задачи, сохраните модель. 

 
Рисунок 54: Привязки для Копирования Элементов Ребра и Уклона 

Часть 3: Завершение Рисунка 
Для завершения сборки двигателя и рисунков детали, необходимо их аннотировать. 

В рисунке детали все размеры являются размерами элементов. В сборочном чертеже, большинство 
размеров существует на уровне компонентов. Сборочными размерами являются те, которые 
используются для зависимостей смещения. Поскольку размеры сборки помогают в описании детали, 
они были созданы в Режиме рисунка. После аннотирования рисунка двигателя, измените размеры 
элементов для демонстрации полной ассоциативности всех моделей. 

1. Откройте motorasm.drw (delta_motor_asm.drw). 

2. Система автоматически переходит в Среду Разрешения Конфликтов. Прочитайте сообщения в окне 
Среды. Система не может разместить крышку, потому что из двигателя были удалены отверстия. 
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3. Используйте опцию Quick Fix для переопределения зависимостей размещения. Измените 
отсутствующую привязку для сборки на ось эскизного отверстия, созданного ранее. 

4. Аннотируйте рисунок как показано на следующем рисунке, и добавьте в углу изометрический вид. 
Помните, что большинство размеров были созданы в Режиме рисунка. После завершения задачи, 
сохраните рисунок и закройте окно. 

 
Рисунок 55: Сборочный Чертеж. 

5. Откройте motor.drw (delta_motordrw.drw, если в предыдущей Части не был закончен двигатель или 
рисунок). Обратите внимание, что элементы, которые были добавлены к двигателю, автоматически 
добавляются к рисунку. 

 
Рисунок 56: Рисунок Исходного Двигателя 

6. Добавьте дополнительные виды, измените масштаб по умолчанию на 0.7, и переместите 
дополнительные виды на дополнительный лист рисунка. Аннотируйте рисунок согласно следующим 
двум рисункам. По завершении, сохраните модель. 
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Рисунок 57: Лист 1 Рисунка Двигателя 

 
Рисунок 58: Лист 2 Рисунка Двигателя 

7. Обратите внимание, что вокруг скопированных отверстий на фланце не отображается осевая 
окружность. Измените файл установок рисунка так, чтобы установить radial_pattern_axis_circle в 
YES. Затем отобразите ось скопированных отверстий. 

 
Рисунок 59: Осевая Окружность 

8. Измените размеры основания двигателя (delta_motor.prt) в рисунке, чтобы его глубина была 7.5. 
Выполните регенерацию модели. Вызовите двигатель в сессию и изучите изменения в детали. 



Pro/ENGINEER 2001 Базовый Курс    

- 322 - 

 
Рисунок 60: Измененное Основание 

9. Создайте зависимую копию основания, используя опцию перемещения на 60 единиц от 
поверхности, как показано в предыдущем рисунке. Добавьте другое выдавливание к торцу основания 
с размерами, показанными на следующем рисунке. 

 
Рисунок 61: Завершенное Основание 

10. Откройте сборку двигателя (delta_motor.asm) и изучите изменения в сборке. В конце, вызовите 
рисунок двигателя и обратите внимание на изменения. Сохраните рисунок, сборку и детали путем 
сохранения сборочного чертежа. 

11. Сотрите модели из памяти и закройте Pro/ENGINEER. 

12. Наши поздравления! 
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Приложение С 

Использование Справочной Службы PTC 

Справочная Служба PTC - инструмент, удобно и легко построенный по двум принципам. Он может 
использоваться для сиюминутных рекомендаций и для подробной информации по выбранным темам. 

Цели 
В этой главе Вы изучите: 

• запуск справочной службы РТС. 

• Поиск требуемой информации. 

• Получение контекстно-зависимой подсказки в процессе выполнения задачи. 

Краткий Обзор Справочной Службы РТС 

Справочная Служба PTC - полнофункциональная система помощи, интегрированная с программным 
обеспечением Pro/ENGINEER. Она может быть установлено вместе с Pro/ENGINEER на компьютере. 

Элементы Справочной Службы PTC 
Справочная Служба PTC предлагает: 

• новую систему помощи с содержанием, индексированием и мощными возможностями поиска. 

• Контекстно-зависимую помощь с доступом к справочной службе РТС по щелчку мыши. 

• Оперативные Руководства, сфокусированные на обучении различным аспектам программного 
обеспечения. 

• Расширенные темы помощи, находящиеся в диалоговых окнах. 

Пожалуйста посетите Оперативную Базу Данных Знаний Технической Поддержки PTC (PTC 
Technical Support Online Knowledge Database), которая содержит тысячи Предлагаемых Методик.  

Использование Справочной Службы Pro/Engineer 

Запуск Справочной Службы: Четыре Метода 
Имеются четыре процедуры запуска Справочной Службы. 

1. Из Главного Меню 
Это - стандартный путь вызова наиболее полной системы Справочной Службы с содержанием, 
индексом и возможностями поиска. В зависимости от скорости работы Вашей системы, может 
потребоваться несколько секунд для запуска полной системы Справочной Службы. 

Щелкните по Help > Contents and Index в главном меню, как показано на следующем рисунке. 
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Рисунок 1: Запуск Справочной Службы PTC 

Домашняя страничка Диалоговой Справочной Службы Pro/ENGINEER отображается в окне Вашего 
броузера. 

 
Рисунок 2: Содержание и Индекс в Справочной Службе PTC 

В левой части окна, отображается список тем в виде древовидной структуры. Щелкая на каждой теме 
верхнего уровня, можно получить доступ к под-темам, а, щелкая по под-темам можно получить доступ 
к подробным пояснениям, инструкциям и советам. 

2. Посредством Контекстно-Независимой Справочной Службы 

1. Щелкните по  в правой части главного меню пиктограмм. 

2. Щелкните по любой пиктограмме или любой части главного окна Pro/ENGINEER, по которой 
требуется получить пояснение. 

3. Открывается окно броузера с пояснением темы. 

4. В следующем примере, щелчок по пиктограмме в дереве модели запускает окно броузера с 
пояснением функциональных возможностей пиктограмм. 
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Рисунок 3: Контекстно-Зависимая Справочная Служба 

5. Кроме того, в нижнем левом углу можно заметить ссылку �See Also�, которая по щелчку переходит к 
списку тем, связанных с текущей, и которые могут иметь непосредственный интерес. 
6. Можно щелкать по любой теме, которую требуется изучить дополнительно. 

 
Рисунок 4: Список Тем �See Also� 



Pro/ENGINEER 2001 Базовый Курс    

- 326 - 

3. Посредством Менеджера Меню Pro/ENGINEER 
1. Щелкните в правой части основного меню пиктограмм Pro/ENGINEER. 

2. Щелкните по любой команде в Менеджере меню. 

3. Открывается окно броузера TOPIC ROUTER со списком ссылок, поясняющих команду меню. 

4. Щелкните по требуемой теме. 

5. В следующем примере, щелчок по X-Section в Менеджере меню запускает окно броузера TOPIC 
ROUTER со списком двух полезных тем. 

 
Рисунок 5: Запуск Справочной Службы через Менеджера Меню 

4. Щелчком в Правой Части Вертикального Меню Команд 
1. Щелкните и удерживайте правую кнопку мыши в меню до появления окна GETHELP. 

 
Рисунок 6: Щелчок в Правой Части Менеджера Меню 
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Перечень Модулей Справочной Службы PTC 

Имеется четыре главных раздела в оглавлении Справочной Службы PTC: Welcome, Основы 
Pro/ENGINEER, Использование Базовых Модулей и Использование Дополнительных Модулей. 

 
Рисунок 7: Четыре Главных Раздела в Справочной Службе 

Изучите следующий список для поиска требуемого модуля в содержании: 

 
Рисунок 8: Основные и Дополнительные Модули Справочной Службы 

 




